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6461 CIVIL ENGINEERING DRAWING (CAD)-l T P ¢
' ' _ . 2 6 4
AIMS

s To be able to prepare production drawing of a multi-storied building.

« To be able to prepare detail drawing of building components.

To be able to acquire knowledge and skill to prepare detail working drawing of a scheme.
To be able to interpret the structural drawings of a muiti-storied building.

To be able to prepare production drawing of multi-storied building adopting CAD.

SHORT DESCRIPTION

5D & 3D CAD commands, Multi-storied building; Multi-storied building (CAD); Detail working
drawing {CAD) of RCC column with footing; Lintel with sunshade; Retaining wall;
Foundation: Beam; Slab; Stair case, ramp and lift core; Underground water reservoir;
Septic tank; Bridge and culvert; '

DETAIL DESCRIPTION
Theory :
1. Understand the functions and uses of difterent CAD commands.

1.1 State the meaning of WCS icon and UCS icon.

1.2 Mention the classifications of co-ordinate system.

1.3 State the necessily of drawing units and limits.

1.4 Mention the functions of the following editing commands:
copy, move, array, offset, trim, fillet, chamfer, extend, break, rotate, stretch, mirror,
changa, chprop, scale and pedit. : '

1.5 Mention the functions of the following objest grouping commands:
block, insert, expiode, whlock, divide, measure, purge, xref fc.

1.6 Mention the functions of the following enquiry commands:

- dist, area, 1d, list etc. ' ' .

1.7. Mention the functions of the following plotting commands:
layout, view porl, model space, paper space.

1.8 Mention the functions of the following dimension commands:
dimension style, Ddim, leader, linear dimension, radius & diameter, dimension,
aligned dimension, continue dimension, base dimension eic.

1.8 Mention the functions of the following geometric commands:
donut, solid, trace, pline; xline, ray, fili etc.

1.1Q State the necessity of hatch and text.

1.11 State the functions of Auto CAD design center (ADC).




Understand the features of multi-siotied bulldmg

2.1 Define multi-storied building. )

2.2 Mention the advantages of multi-storied building.

- 2.3 Mention the disadvantages of multi-storied building.

2.4  Describe the main features of a muiti-storied building.

2.5 Describe the process of drawing' of a multj-storied building.

2.6 List the drawings of a multi-storied . building necessary for approval of the relevani
authorities. ‘ '

Understand the preparation of plan, section, elevation and other components of

multi-storied framed structure buitding using CAD. _

3.1 Describe the process of drawing the site plan and layout plan of a multistoried
framed structure building.

3.2 Describe the process of drawing the plan elevation and sectional elavauon of a
multi- stoned framed structure building.

3.3 Describe the process of making the detailed drawing of beam, roof slab and lintel
of multi-storied building. . _

3.4 Describe the process of making the detailed drawing of staircase, lift core and
ramp of multi-storied building.

3.5 Mention the advantages of making the necessary drawings of multistoried framed
structure building using CAD.

Understand the preparation of working drawing of RCC column with footing

Foundation using CAD.

4.1 Describe the process of drawing the plan of square and rectangular colurnn with
footing showing the reinforcement. _

42 Describe the process of drawing the sectional elevanon of RCC column showing
the rainforcement,

4.3 Destribe the process of drawing the detajled working drawing of circular RCC
column with footing showing reinforcement. : _

Understand the preparation of the working drawing of RCC lintel with sunshade

and RB lintel using CAD.

5.1 Describe the process of making the detailed drawmg of RCC lintei showing the
reinfoercement.

5.2 Describe the process of making the detalled drawing of RCC lintef with sunshade
showing of reinforcement.

5.3  Describe the process of making the detailed drawing of RB fintel.

Understand the preparation of elevation and cross section of RCC cantilever

retaining wali using CAD.

8.1 Describe the process of making the detail elevat;on of RCC retaining wall showing
curtailment of reinforcement.

6.2 Describe the process of drawing the cross section of RCC retaining wall.

6.3 Describe the process of drawing the counterfort details showing reinforcement
including retaining wall.
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Understand the preparation of detailed drawing of foundation using CAD. [i

7.1
7.2

73

7.4

7.5

Describe the process of drawing the spread footing foundation.

Describe the process of drawing the raft foundation showing the reinforcement
detail.

Describe the process of drawing the pian and sectional elevanon of plle showing
the reinforcement detail.

Describe the process of drawing the plan and sectional elevatlor of pile cap
showing the reinforcement detail.

Describe the 'process of drawing plan and cross sectional. elevation of well |

foundation showing the remforcement

Understand the preparation of working drawing of continuous rectangular beam
and T-beam using CAD.

8.1 Describe the process of making the detail drawing of RCC fully continuous=
rectangular beam showing reinforcement.

8.2 Describe the process of making the detail drawing of RCC fully continuous T-beam
showing reinforcement.

8.3 Describe the position of reinforcement in the function of column with beam.

Understand the preparation of plan and section of one-way and {wo-way siab

using CAD. . ' o

9.1 Describe the process of making the detailed drawing of semi-continuous one-way

9.2

9.3

9.4

slab showing reinforcement,

Describe the process of making the detailed drawing of fully continuous one-way
slab showing reinforcement.

Describe the process of making the detailed drawing of semi-continuous two-way
slab showing reinforcement. | '

Describe the process of making the detailed drawmg of fully continuous two-way |

slab showing reinforcement.

Understand the preparation of plan and sectional elevation of a half turn staircase,
ramp and lift core using CAD. '

10.1
10.2
10.3

104

105"

Describe the process of drawing the plan of a half turn staircase.

Describe the process of drawing the sectional elevation of a haif turn staircase.
Describe the process of making the detailed drawing of a hali turn staircase
showing reinforcement.

Describe the process of drawing ramp with showing reinforcement.

Describe the process of making the plan and section of lift core showing the
reinforcement. : ‘ '
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11.

12,

13,

14,

15.

16.

Understand the preparation of plan and sectional elevation of an underground

water reservolr and septic tank using CAD.

11.1 Describe the process of drawing the plan and sectional elevation of an under
ground water reservoir showing the reinforcement,

11.2 Describe the process of drawing the plan and sectional elevation of a septic tank.

11.3 Describe the process of drawing the plan and section of soak pit and inspection pit.

11.4  Describe the process of detail drawing of a water closet including gutly trap.

Understand the preparation of detailed drawing of two span box culvert using CAD.

12.1 Describe the process of drawing the sectional pIan of a two span RCC box cuivert ,

12.2 Describe the process of drawmg the cross section of-a two span RCC box cuivert.

12.3 Describe the process of drawing the long section of a two span RCC box cuivert.

12.4 Describe the procass of showing the arrangement reinforcement in a two span
RCC box culvert.

Understand the preparation of detailed drawing of T-beam decking bridge using CAD.

13.1 Describe the process of drawing a half top plan and half plan (decking and earth
removed) of RCC T-beam decking bridge with splayed type wing wall.

13.2 Describe the process of drawing the cross section of RCC T-beam decklng bridge
showing the reinforcement.

13.3 Describe the process of drawing of wing wall, tumn wall raiting and bed block of |
RCC T-beam bridge.

Understand the interpretation of the factory building drawing with steel truss.

14.1 Name different components of a steel truss.

14.2 Describe the preparation of detail drawing for a factory building with steei truss.

14.3 Explain the necessity of interprétation the drawing of a factory building with steel
truss.

Understand the drawing about 3D using Auto CAD.

15.1 Explain about starting 3D.

15.2 Explain how to create 3D objects/modei.

15.3 Explain how to draw isometric view.

15.4 Explain about Edgesurf, Rulesurf, Tabsurf & Mesh.

15.5 Explain the uses of co-ordinate system in Auto CAD.

15.6 Explain how to create surface modeling.

15.7 Explain tha use of 3D editing commands.

Understand the perspective view with rendering lighting & imaging in Auto CAD.

16.1 Explain how to creating perspective view.

16.2 Describe the use of distance and camera in perspective view,

16.3 Describe the rendering and materials effect in 3D.

16.4 Describe the uses & satup of background in 3D.

16.5 Describe the lighting & shadow in 3D.

16.6 .Describe the uses of showing images in 3D.

16.7 Explain how to print 3D view.

-
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Practical :
1.

Prepare plan, section and elevation of multi-storied building using CAD.

1.1 Draw the site ptan and layout plan of a multi-storied framed structure building.

1.2 Draw the plan, elevation and sectional efevation of a framed structure building.

1.3 Draw the detailed drawing of beam, roof siab and lintef of the building.

1.4 Draw the detailed drawing of staircase, ramp and lift core of the building.

15 Draw the RS plot map showing the site of the building with necessary items for
approval of the relevant authorities, '

Preparé the working drawing of RCC column with footing, raft and pile foundation

using CAD. _ o o '

21 Draw the plan of square and rectangular column with footing showing the reinforcement.

2.2 Draw the sectional elaevation of RCC column showing the reinforcement.

2.3 Draw the detailed working drawing of circular RCC column with footing showing
reinforcement. _

2.4 Draw the detailed drawing of raft foundation.

25 Draw the detail drawing of pite with pile cap.

Prepare the working drawing of RCC lintel with sunshade and RB lintel using CAD.

3.1 Draw the detailed drawing of RCC lintel showing the reintorcement. '

3.2 Draw the detailed drawing of RCC lintel with sunshade showing reinforcement.

3.9 Draw the detailed drawing of RB lintel.

Prepare elevation and cross section of cantilever RCC retaining wall using CAD.

4.1 Draw the detailed elevation of RCC retaining wall showing curtailment ot reinforcement.

4.2 Draw the detailed cross section of cantilever retaining wall.

4.3 Draw the counterfort details showing reinforcement including retaining wall.

Prepare the working drawing of continuous rectangular beam and T-beam using CAD.

5.1  Draw the detailed drawing of RCC fully cantinuous rectangular beam showing reinforcement.

5.2 Draw the detailed drawing of RCC fully continuous T-beam showing reinforcement.

54 Draw the junction of column and beam showing the reinforcement.

Prepare plan and section of one-way and two-way siab using CAD.

6.1 Draw the detailed drawing of semi-continuous one-way slab showing reinforcement.

6.2 Draw the detailed drawing of fully continuous one-way slab sh'owing reinforcement.

'6.3° Draw the detailed drawing ot semi-continucus two-way sfab showing reinforcement.

6.4 Draw the detailed drawing of fully continuous two-way slab showing reinforcement.
Prepare the plan and sectional elevation of a half turn staircase using CAD.

7.1 Draw the plan of a half turn staircase.

7.2 Drawthe sectional elevalion of a half turn staircase.

7.3 Draw the detailed drawing of a half turn staircase showing reinforcernent.

7.4 Draw the detailed drawing of a ramp showing reinforcement.

7.5 Draw the detail drawing of a tift core showing reinforcement,
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10.

.

12,

13.

Prepare detall drawing of underground water reservoir and septic tank using CAD.

8.1

8.2
8.3
B.4

Prepare detailed drawing of two span box culvert using CAD,

9.1
9.2
9.3
9.4

Prepare detailed drawing of T-beam decking bridge using CAD,

10.1

10.2 -
10.3
10.4
10.5

Prepare the drawing with steel truss using CAD.

111
1.2

Perform the preparation of 3D objects in Auto CAD.
121

12.2
12.3
12.4
12.5

Perform the preparation of the perspective view with rendering lighting & imaging
in Auto CAD

13.1
13.2
13.3
134
135
13.6
137

Draw the plan and sectional elevation of an undegrground water reservoir showing
the reinforcement,

Draw the plan and sectional elevation of a septic tank.

Draw the plan and section of soak pit and inspection pit.

Draw the detailed drawing of a water closet including gully trap,

Draw the sectional plan of a two span RCC box culvert.

Draw the cross section of a two span RCC box culvert.

Draw the long section of a two span RCC box culvert.

Show the long section arrangement in the decking of the two spans RCC box cuivert.

Draw a half top plan and half plan {decking and earth removed) of ACC T-beam
decking bridge with splayed type wing wall, ;
Draw a sectional elevation of RCC T-beam decking bridge.

Draw the cross ssction of RCC T-beam decking bridge showing the reinforcement.
Show the details of T-beam of RCC T-beam bridge.

Show the details of wing wall, tum wall, railing and bed block of RCC T-beam bridge.

Draw a drawing of steel truss for factory . .
Draw a drawing of steel truss with simple building.

Create simple 3D object in Auto CAD.

Draw isometric view using snap & isoplane command.

Create 3D surface by using 3D poly Edgesurf, Rulesurf, Tabsurf & Mesh.

Edit/draw 3D object using polar co-ordinate system.

Edit 3D object using different editing command i. e. align, rotate 3D, array 3D,
mirror 3D, move, chamter, fillet, trim etc.

Set the distancet create perspective view.

Set the camera to draw the perspective view.

Draw perspéctive view df an object using 3D view command.
Set the material from material fibrary for rendering.

Set the background color/image for rendering.

Set the light & create shadow using different command.
Draw perspective view of an object with full rendering.
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TR A-d0 OBl WCEH AR U (Tfhe Frem fod www 0 0, e
TAW-DY  WIBRICSS ARITE -6 SROTE T8 1 e W
TSR A SRy i, iR 9 R0Iws BTF OTSW e, W
| GTTE.......cooereemeromsersersasesssesosissssrssesntbesssssessasmssstrasssassssassassasissesserss e
[ | T T I BT . ..orveeererevesrenrrereraerssneninssersnsrene sameessonrrassans dnerassssonntonae ®od
[ | AR EHD ...t eeseeesrerseersaserseessassesssensssassensas ©IB-0¢0
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H

RS 23T 310 TATS
(ifferet AD commands)

3.5 UCS Wig34 (UCS icon) 8

ucs 5 User Co-ordinate System (389 (FI-STETH5 f7BW) | 7 T x, y 9% z F0wA T frnt aa
W/ UCs w3 e Afids == T '

Tools (VRS UCS &7 ¥y SopA e, T ¢

\

faewnob\\

Regenerating model .
ALAutoCAD menu ut11ﬂt19q
e ————

&7 5 3.5 UCS icon

1. Named UCS------
2, Orthographic UCS
3, Move UCS

‘4, New UCS

wCs Wigza (WCS icon) $
wes wg World Co- ordinate System (€TE F-SETH ﬁrn‘?n) | a7 fres SRR 9 W A | 4TS @ (TR

A (-
— BT TR x ATEDS (x +)
«— ATH (T x A0S (x - )
1 Boiza o y AREDS (y +)
J fo o y o (y )

3.3 YFAITET AFHTSA (Classification of co-ordmate system) &

Auto CAD ¢ &TSIFH 3¢ (31 7 (31 YE (Co-ordinate) (& AL TR

2D Y% (2-Dimensional co-ordinate) ¢

aw:(aaaymmcwmm |

UCS icon 9% TIHICH x, y <7 fir B 30 | UCS 10w 5 User Co-ordinate System.



3 ffSar Ffafrmfac g2 (@me)-y
3D Y% (3-Dimensional co-ordinate) 3 A
x-SR (x-Axis), y-STIWT (y-Axis) Gz STRATTE (z-Axis) A= Fty 93% 3D yam e | s
%ﬁrwmmﬁmﬂfmwwréwmmwl .

+ Y.axis

19
T8
T 7
T 6
+3 6,5
-+ 4
-3
42

~Y-axis

@ 1 5.2 2D Co-ordinate system (8- waw)

Y-axis

8 £ 5.0 3D co-ordinate sysiem (%-f5 T}
Co-ordinate «¥ &¥MTS (Types of co-ordinate) 3
Auto CAD d &4 €417 Co-ordinate TR%7 331 Tw, 721 ¢
1. aresfees @I-‘Wﬁ:ﬁf (Absolute co-ordinate)
2. Fwitw -wfE=s (Relative co-ordinate)
3. (R B-WBTTB (Polar co-ordinate) |



S

- a

Absolute co-ordinate 4 ‘E[Flﬁ"i

ffen e FTe IS
3. SIEAES (FI-SfEE0 (Absolute co-ordinate) 3

(0, 0) T FETIT O T 1 PRSI (0, 0) CATIR T AR T 1.

Command : Line
9 =
8 e
7 —
64
5 T ~""""" - 1
T « 7,5
eI v
| 4= 2.2 :
ANNEEEEE NS
12345678 9101112
fow s 5.8 Absolute colord.iuate
. Command : line Command : Rectangle
P,(3, N P,(10,7) P, (10, 7
P,(3, 3) P, (10, 3) P 3. 3
0,0 5 X (0, 0)

Relative co-ordinate @ C8R {49 A AW ATF szl fepr TR IR T T AR (R W @

153 2 3.¢ Absolute Co-ordinale

R Reaits -0 (Relative co-ordinate) 3

o=t 25 IS 2V |
Command : line Py
P,@-5,0 @0, 4
Y 4
- @lo,-4
. P,

Command : Rectangle

@S35, 4

P, 4,4

P,

0,0 ——

X

(¥) Relative co-ordinate

" (¥) Relative co-ordinate

TR

I




Fifee fafrmfa g2k (w11e)-2
Relative (-85 *&fers 7@ wqeia e w4t Ti3, qe1 3
. @ —4, 0 : _ _
@0,-2
. @02
@-3,0 @-3,0
@0, :
4,2 @10,0

0,0

femesq

O, I (-5 (Polar co-ordinate) 8
Polar co-ordinate & (PTCTR #Hfe1et fefiTe (@141 20 @9 (T (7 T30 TG (21 A0 |

(t¥c) v\

A g
180" « — (07 or 360°
k 2
* 270°
B ¢ 3.4 ()
Command : Line
P, @ 6<45° P = Absoiute
T p; = Relative
_ p; = Tolar
B, @ —6,0 P, 10,3
0.0
feas s {3} Polir co-ardinate
Command : Line
p, = Absolule s @ 10 < 180" P @ 6 < 90°
P: = Polar :
py = Polar
p, = Polar 6
@ 6<270° 10
n@4,2 P 10<0
{0,0

foa 2 3. (1) Polar co-ordinate-a7 TETT 97 weTTT wew



fafeq g=ta I FAS D
AR TS T (TP C1-SfSTh TN

Comn;and: line
@3 < 180° @2<90°
@ 2 <270° .
2,2 @3<0
(0, 0)
fFagsa )
aimﬁmmwwmmwﬁsﬁmmma
Command : Line
@3 < 180°
@1 <90°
i< @<
- @1 <90
3 < |80
@ 3|< 270° @
1,1 - @9<0
0,0 (F &)
fBa 2 5.0 ’

8. SIBIENS (AutoCAD) 8

CAD %2 f&r=rad ¥ Computer Aided Drafting or Design. W 117] FFATER e R W ufbe
G AT (8 | 7 T ST WA Bk el TS i, 4feB wars +1f7 @Te e Frs <1f | RfeF

oy

W 2D, 3D H3R @3 X FECE G2 TR CBfd I W | SR AT TR e SRR (Unlimited) G2

5, fafn @ o 4 ¢ @3 fafen creTATS Gor (sifnes vE) Tt

TR TSR AutoCAD @¥ RFEY THA (Version) FCHTR | T41= AutoCAD 2000, AutoCAD 2002, 2004. 2006
2007, 2008, 2010, 2012, 2014 €3 2015 TOT | @F TXCS 2004 (S TP S THTE | L7 @AM Update (=nyfes)
ST User friendly, 5@ (o7 &) @forbieas i A ATHE= TW |

¢. wiREGFsRm 3 Yafwifr vt SEITEd STETS! (Necessity of Aute CAD in
architectural and Engineering field) 3

AUoCAD @ W fenta/grel e | WREGETEm A ArsEm @ ER-3 &= W @ 9
W(Manually)ﬂtmaﬁv@mmﬂmwmwammmmﬁm&maaeﬁggﬂm
wmnmmﬁa%alﬁﬂ@emWMmﬁgmmx

mﬂawmaﬁwmmmﬁmlmaﬁmwﬁw@wwm
mr-nw,-arf-‘.«m’-!,vrﬁmfwﬂ:r-nuai‘wﬁwm|Wmmzmwlmmw&waﬁmaaﬁﬁﬁm
mwamﬁ@mmﬁm%mﬁwwlmﬁmmwﬂmﬂ%&
TS g, ferEss Lo wafeTel =41 I '



D e 2fafrmfie g% (F71)-2
fafen mﬁf@mwﬁ@m%ﬁ%ﬁmmﬁcﬁmmamwwmm
WEIEER A%y e weta vy | T-
AutoCAD Map
Autodesk survey
Auto civil.
Civil soft
3D Architectural Home 251f¥% |

b, SIS ‘GI"F{W e % 4t (To open and exit from AutoCAD) 8

APH Drawing WF ¥ (Creat.e New Drawing) ¢
WCHTEIE AN JATA Startup G IET ST A |

fBm g 5.5
Startup ST AH SR A6 A A ACATR | [FSH (1 WIRE ST IR S AN ST R 5
wvﬁﬂﬁwemwm|%Wﬁwmvﬁa@wmﬁqw'wfﬁmﬁaﬁcﬂSMﬁom

search ATER ITA T B3R &F T T ( 97 AR WREAG & Use a template S22 | @7 AR o tefd
mTemplatewmIﬁ\W‘mll

. - oM Tsruuenmum
: Nuderﬂd'n{edwlﬂm)dthG UustludPH&m




- -

- e S IS Q9
QUHTE WA I IR, Drawing file 93 Extention %8 dwg @32 Template file 49 Extension T dwt 1 0T
SiEFAD T Use a wizard WIZIH | @7 6 ST 3TI0E | S oo

CfRms e

'3 | Advanced setup (STTESTTS (FO-SI%) &R
3 1 Quick setup (FEF TB-A) |
Advanced setup BRI 3

TS GRS SEHTEA FORGT 2 3

3 | Units 108, '

3 | Angle G,

@ | Angle measure,

8 | Angle direction A%

@ | Area




ffem Sfafrmfie mRe GO
> 1 Urits (TR @7 Tiasew Decima}, Engineering W3 Architectural R Soper (fBe < AT
2 1 Angle (ifBR 92 MYITX Deg/ minf sec T3l AR 21 TR | '
® | Angle measure (F5e &I Angle I =IToR FW bR, FaTe oW |
8 | Angle Direction @3 {6 &+ | quif- {¥F) Counter elockwise Anticlockwise @2t (%) Clockwise |
€ | Area CHIfR W1 Width @2 length & XN (78 W |
Quick setup WY 3 $Fw M SRy it e 7ty | aut-
(F) Units setting (TEFT crfbe) . '
(¥) Area setting (AR M) o

|W§"{ Drawing O%F T4 G300 ITH SHW (Easy method of create a new Drawing) ﬂ

@3B TEH Drawing a3 F1e RAGTOR o T T GrS qArEtet @ Baw R | R @eTE e
‘ wﬁsﬁmmwmm:mﬁmﬁmumpiate 1SR SNS Drawing 41 433 Axw ¢ o @

A1 A T~ :
51 File (49 (UTF New sclect ICA GG &9 Decimal, Engineering 3l Architectural (feet, inch) 3®Tf% GifBe
TS BTy )

1 Units 31 W28 Decimal, Engineering 3 Architectural (Feet, inch) T 15: wars TR
© | TIRFTTS Limits 1S AT Drawing Area At TSI 6 37w 02 | o~ T 70" G B 507 N
100° x 80" 3eTW (0 (T WH ¢t A1 |

Dimension (12 TS %4 | SRGEHR Arrow size, Text size, Units TS7%2 gemae T fire 72|
FEBETT New layer (SR TS 77 |

TS T G Title plate G9R TR 7ETS 1@ o 4R |

A. SO 911 Frew Rf%s SRR (ifferent parts of AutoCAD Graphic window)
- bar

Titte bar L]

= s o

HHE |

ARG+ ®

1
-

i

mASILO

Bt 3.5¢ WS anferm e



Fafeg et TS TS : ae
3 | Command line $ Q%6 SIER FATGTS 72 T2 Enter BT TH | _ o 1
| UCS R 8 X &% O Y WUwa o fad a3 | i
© | Crosshair bar 8 PR IEUH ST A =04 | ' el
8 | Toolbar (RPRIF) 3 o . ‘%!
sifirs W fafeq wm o erfa =0 T | 3wt- - - |
Standard toolbar (FBTSTE M),
" Draw Toolbar (§ PoRm®), . -
Modify Toolbar (JfETE Faam) Tenft |
¢ | Layout Tab (C'I-Wm BTR) ¢
Model mmwmﬁmﬁwmﬁ&wwlﬁmﬁmﬁmﬁ&ammmm
T layout BIAGTE FATR TR QTS W |
¥ 1 Menu bar (¢ ) 8
g o IREE e 3@ e T
q | Drawing Area (G2 afm) ¢ ’ '
(TATEA {76 93 Command window-43 BT Status bar AW ﬁﬂl T e 'ﬂ"l"ﬂ WS E'?L afam @t
¥ | Command windows (ﬂ“ﬂsm) H
%TTS 83081 Command prompt, command line TSI #eg siffe | (AR STl BRI (T (W IS e o
Command window-C% W T | ' '
® | AutoCAD Text screen (STBIE RO ) 8
BRI B IAR AT F, (47 I R F Afie 2w, WWMWW@W/
(FTL TS AT | mncmwﬁﬂﬁmml

|sPesTry corner of viewport or *
{Oltforn‘rit{smdepxo;/mak/onjec:{rolyqonauneuou.'uyernlsii] <Fies: L
iewport View Locking [ON/OFF): gn

found ¥
wert NOC B Viewport. ;
were rot Ln current Space. 4
1 was the paper space viewport.

;j8elect objacte:

53 3,50 (5B @
AutoCAD -21fs Fea Fre (i f3fy =i Fmmwe | a9
(%) Command window % FATS A AR IS P |
(%) Menu bar (9TF g SIRDY 08 =04 )
() Toolbar 97 SR WA 7% 3@ | ‘
(%) Side screen-99 G AT (YETRA afbe a7 R L 5) |
43S R e Boiwm TReE ofem et @ oW 93 afiFm omm T WSEE AR @ W
QoS efEF CT A | NS AL (RE WA MR 5 TR S I ST TG | S AW A TS
@I IZTE 5= SITd T Command line -4% FAMS o0 181 41 I7Rersd |



frfem Rfafmiae WE&_ (F71%)-3
b, SRITTR FZIT (Uses of icon) § :

6@ s 5.9 f%’r?bﬂ?ﬁ?m
 FRF Floating toolbar 9% Shape “#¥$H w1 7w | wefj—
(%) arifix FRICA 0% T8T €0 Drag I Vetical toolbar TR |

' : - bt 5 3.0
(%) e peraizen %S A 407 et T Horizontal toolbar 7R i

. 7 S CRIGR I_RRA (Uses of pull down menu bar) ¢

[Dvawingt.dwg]

5@ 5 .08 AR : o
COFRIGR (X (I (s e e T s frss fire aifis o gt « N P TIeA (W | T TR
@ Fata frraitem v s Rt Wiy _ - _



fafen et =7re s 24

+le Distance
R iRadis -
5 ooyl
" rel and Block In-plece Edding Ve
B |Deia Etraction._ {3 Volume
Dada Links - -+ |G " RegionyMan Propertias
U . .- R
G Losd Application.. - ] ' ID Poink
B RunScriph. @ Time
‘Moo v sm
AutolSP v 1 IR Sl Variabie
. Display image _; .
New UCS . L
=] Named UCS-.
@ EGenguphu: I.nuhon_
CAD Standards r
Whzardt ,
- Draftinng SETAGS...
“Table .
Customize : L4
3 Options...
fom § 3.20 7 SIEF a1g

Yo. IS TZrS! A i Wt (Command area) 3
ﬁmﬁmﬁwmmmmwmammﬁﬁmqwmmm@mw;

{l|Settings \TexpsDravingl 1_ 1 8467 .s%$ ..
BCommand . #Cancels
tUCommand : ®Cancel#

hutcnat:.c save to C. \Dcr:unents and Sett1ngs\Mn1n13tra|

- o s s mﬁ‘m
R EQRW & WfifB (Drawing units and limits) 8

Units FTSA 7T ~fFwiees «2 33 3=t 7w | SR awem Aub Some qung | 14t 3
Decirnal,
Engine:ering.'
Architectural,
" Fractional,
5. Scientific.
mamﬂtwtmmiawﬁmmm| - Po-Bfes aw&itm{cﬁuﬂtww
(Architectural) TTo8 F7CS T 1

N



frfem Zfafmie 53¢ (37e)-2

_ B g 3.2 - | - 5z 2 .29 Units mﬂ =
Limits FNICER R0 &R 9= «f R s )
Drawing limits (4% 3
436 Object €2 fom WiRFTs fEeat usfe afya planmn—}‘f@\ i fee Qrewify mrswm g
Nwﬁqmﬁﬁmﬁ Limits T3S G5 IS TLA |
A 3

N F-JMT (AT Esc ﬁt@ﬂﬁﬁmmﬂﬁﬁwwwm:

Command window (% 5135 708 T3 |

Limits .| {(Enter key)

Prompt : Lower ieft corner 0,0

Respond : 1 (0.0 (F (A (FAM )

Prompt : Upper right comer

Respond : 60', 50 (Architectural units €3 TF)

Py =Lower left comer. _ _ P, 60" - o~

DRAWING AREA 50°

1
<

P; = Upper right comer.- ——
’ : o 3 .28
lenswmmﬁzaﬁWcﬂﬂﬁmmﬁwm| m—m\wrﬁﬁmw

Wmmmeﬁﬁ%mwmuwmaﬁﬁm@ IR T | (cm) G Z7o S
s a N6 Iume o A

. 7 @IS Limits 9% (AR vm Command line @ Zoom Tt @B1e W 23|

aaﬁ'«tAnf@maﬂ?ﬁmm:zoom-Anmﬂmm#&ﬁ\aﬁﬂﬁﬂm&mmW|\?va
Wmmmmmﬂmmmmomwmdowmﬁmml ' . .

7 % 4//

1. Zoom All 2. After zoom -window
f5@ 2 3.2¢ Zoom-window 97 &fFm

\\

3. After _zoorﬁ window



fafoy azia e IwE W
3.8 «fSfr FS (Editing commands) $ .

r(a) Copy command (3% FT1®) SI _
@ ST M QF6 SRS 9% FAE g 3 T W) : %
A A
M ‘ Py
' o Ry
Tl &

Modify (T (4TF Copy e 392, W TS LA Copy o=l @5

Select objects : A SRTEHHA O (T ¥ 38 723 '

Specify base point or displacement : (5 T8 fre @ e uTFfP feq g v (v P |
Specify second point or dlsplacemem 42 P, 1 oA P, f49rs A AT B T AR |

I(b) Move command (‘5_{@ D) |

awamwﬁw@mmawwmﬁ—wm|ﬂmmmwﬁﬁ‘ﬁ@awmm
Tl ¢ _
Move TS JAIE FA FA FINSG TC AL |

[(c) Array co

W TS HREG GfES FfH o

Array ¥ &% 447 8

(T) TTSIHR A (Rectangular array)

{d) H"ET?: WA (Polar array)

“rmz Tenls oPRfen 1 (FW OF0 AEfers SR FWE O AW 3
(@) TS TIILT array 70 '

(%) TreTd FEAE array W30 38 B0q |

(1) WfETTB 39 (ATF array (FCTY FH | N

3.2

2.1
12 ER K]
BATER TR T eﬁa«fmwww|aaﬂamﬂﬁﬁﬁmm|

Command : Array

Select object : Tfrraftre Fers w3t o |

Enter the type of array [Rectangular/ Polar] <R>: TSI TR T Y G618 IS A |
Enter number of row (...} <l> : 4 0 @18 51973 =74 | ‘ '

Enter number of columns (I1]) <1> : 5 104 @761g HiwTe A



: frfea Zfafennfae wXe (F7w)-2
Distance between row or specify unit cell (.........) : 1.50 4 @B 51ts 70a |
Distance between columns (IIF) : 2.0 Tt @M 519t 277 |

: g s.ar .
SREA TN TR W 4 rows 93k 5 columns FAMHE wita ofd 21 |
S TS ARITY TSR I SO abjects Ly s o 7ot 3 -

Haque
" Publications



. e s e TS | | o)
[(@) Offset command (S0 ) 5|

awm@momeets@%mﬂwwlwwMEwwmw 00 7 o
TS| G316 STSTHFY W] FA AT | . f%

QT TS AW FRTS T 3.5

Command : Offset 4

Prompt : Specify offset distance of [ 1hr0ugh] <current > : 15

Respond : 0.25

Prompt : Select object to offset : Brgseo |

Respond : WESTwaBy B+7 e fre

Prompt : Specify point of side to offset :

Respond : mﬁﬁmmmmmwmﬁwmmﬁmmﬁmlww
ot e FeTm 4R e T3 |

| (¢) Trim command @T[ ) 8

QB REE T W QI SRS WL PR A Trim IS IS 2 | Erase FAS 8 Trim TS 4F
W|Erasemwmwcham wﬁﬁmwmﬂﬁmﬁﬂwm1

Command : Trim ./

Select cutting edges ...... J

Select objects.

amaﬂmﬁmmﬁmmmﬁmqm UETES
TICe %@ | SEA Cutting edges 1 Objects ¢ P
Breerd =T T | =g

e a9t B W faewlG A w0 1w =

Comumand : trim J -
Prompt : Select cutting edges _......

Respond : -
Prompt : Select object to trim : Before oim -+ Aflermim
Respond : Pick on P, and P, ' . 6 5 5.93

Trim IWTST AT L& Tt Objects @ fort Fm e 1A ¢

fors e

[(D Fillet Command ¥z =47%) 3 |

7f6 Non pa:allel. object (¥ (Line, polyline, circle, arc) ‘ﬂtl]’{@fw TR TR AYS FA RiE
AR @tF Modify > Fillet

Prompt : Polyline/Radius/T rim/<Select Fll‘Sl cnbject‘?l

Response : R (Radius)

Prompt : Enter fillet Radius<?>

Response : 20

Commuand :<Enter>»




B N S —— T

LAY ' e e 52 (F018)-2
Prompt ; Polyline/Radius/Trim/<Selgct First object?
Response :A line forzs e 99

Prompt : Selects secend line
Response : B line Bz Breas 371 <Eater>

SrRTA TR WOy Wi R o Zome |
TIPS : Fillet Command T8 9TH W05 TN f=RR o) SRR Fillet Command W18 | Radius &R 0
G165 T | SIEE WA ST SRE e eeRR |

| 1 (g) Chamfer command (o FqS) Sl

Chamfer command 3t % Non parallel line (¥ =] 9=t el AR W A T A | ARIS! qiv g
BATE Beval T Sdie 413 AFTAT T |

(T (9TEF Modify > chamfer 7088 39 | &
Prompt : Polytine/Diswance/Angle/Trim/Method! (Select first point) - &
Response : D (Distance) _ Q-g;‘
Prompt : Enter first distance i _¥

= Chamfer
Response : 20 _ _ |
Prompt : Enter second distance Second distance
Response : 20

(Y9419 TS Modify > chamfer ' _ A
Response : A line ot e = | '

Prompt : Seclect second line

Response : B iine f0T% ot @7 foas vo0
.I(h) Extend command (435S FIS) SI

AR SIS Cau— o1i3d, AFEA, wid Fenfrr g «zfd R Boundary "8 I T @R Extend
command =5 |

(TR (AT Modify > Extend o

Select ¥4 | ‘

Prompt : Select boundary edge

Response : (7 Object *¥® Extend FATE e s =21

Prompt <Select object to extend>/Project/edge/undo
Response : (¥ Object ST} 4G BI8 i Ao

EIEA Obdject ST Extend W 1T |
(i) Break command (% FTS) 3]

Break command %1 (P T3, G, 7 IIT 2D polyline ¢F 76 Point @& TSt Wt (T A St
T | Break Command 93— '

S 1 (R G e (TRl 3 Shet W

3 | FAfeB sifamia s fAfiE st oo e |

S | (IR (XTF Modify > Break 918 33 |

Prompt : Select object

Chamter

Response : P point click 3% |
Prompt : Enter second point
Response : P; Point click ¥4

T P (AT Pﬂ;ﬁfﬂﬂwmm|



(&) Qb-(m) SRR B kel

fafeg @ e TS

3 | (R (AT Modify » Break 1078 27 |
Prompt : Select object

Response : {8 #1234 =g a7 |

Prompt : Enter second point {or F for first point)
Response : T

Prompt : Enter first point

Response : P, ﬁ"{ﬂ fFs 3

Prompt : Second point

Response : @ 100,0

A Py RS 100mm 9@ Break ICNCZ |

Rj) Rotate command {THE INE) 3

aicommandWWmemamﬁ?ﬁﬁﬁmwmm|

FAS ¢ Rotate

Prompt : Select object t6 rotate

Respond : SRCT30 Bod 9,

wesed A e w'm%% Rotaté 30T (A6 P8 3L Enter 7194 |

(k) Stretch command (GIV IWTS) ¢

Q@ TS R SATHCI (T S T #iasa a1 T, (b 391 WY, Sigfs A v 7w |

' 51@f% $ Modify T (473 Stretch ¢ g @1
A FAM AZA-S
Prompt : Select object

Respond : (U SIATHE 3l TACELHI (T W

{rossing window

Alter stretching

Gofee TS WA OIF Crossing window 91

Crossing polygon on #0899
GAHY | Enter (4% %9 |
Prompt Specify base point or

displacement

Respond : SRCEE (A (I T fa 703
Base point fRf#3 &% |
Prompt : Specify second point or displacement

Bms .08

Respond : mﬂwﬁﬁraﬁmﬁ—mmmﬂmﬁawmﬁm@aM|

O TG R (F Fgd/oarenda aifefem @
I G 7R RIHE. AR e 3G oS @9d
7Y | S% G0 B0 § TR WA Micror FH I |
wiRee 95 TEFGE E 208 AR '

Command : Mirror

Prompt : Select object

Respond : RIS/ SRCSASES FE3 FI0T A |

Prompt : Specify first point of mirror tine

Respond : Mirror line (¥ FrEy v WA

] )

Before mirrar After mirror

8 3.00

ST/ SRCSTRGTS ATHISAIG AT (T G7 6197S TR

Prompt : Erase source objecis?
Respond : .!
]



|
|

_ e Helrmie: 5z (3718)-3
L(m} Change command ((58 %) 3|

 FRCER AT §3R 99 Layer, color, linetype, elevation, thickness entv offada @y I
FAT 3 Change

Prompt ; Select object

Respoad : . (Object T8 T2 @817 29 +q1)

Prompt : Propertise/<change point> -

Respond : P -

Change TS SR &7 AR S 4 W | [ 3

51 Text W (&S Propertise/point TSI |

Q| T Object 47 Propertise T &g |

2 | Object Q3 SRS/ Tonfv

| {n) Chprop command (Fi9%p a+) 3

)i -Change BUMST Change propertise TALTA Afmg 79 | wre, ST Change TIMEZA Change point
TA=G (78 | Chprop TS AR FACECIR (4668 Propertise #ifR<$a 3521 113 |

FAZ ; Chprop '

Prompt : Select object

Respond : HATEH 773 B G2 (21 S

Prompt ; Change whal propertise (colow/layer/linetype/thickness)?

Respond : TofeEe gy (U @ W @G goie fdise =1 |

‘ (O) Scale command (CF9 F41S) 3]

42 TS WE CULAA Qbjects W 7EH x 42 y SO0 Tt (%iB-aw <41 7/ |

Command : Scale |

Prompt : Select object ...

Respond :ﬂ“ﬁ‘f Object & T8 S TR |

Proinpt : Base point . :

Respond : (7 (@ a3 @7 40 fre g3 1 (Object 43 @30 FiL7 W8 e

Prompt : < Scaic factor »/Reference :

Respond : 3§ 19 &) 2, 3 ToNf W3e (@B 341 &) 0.5, 0.4, 0.25 Twf focd 95ia w1oie <77 |

TMRmmTmmmm

”JHMNLMJMMJII I IHM

5 g 5.0

(h)e-x-(alle) 2 3EpisieBE Loaye)



()2 -2-(oul) S8 SBiitbiellE boalie)

e g FE TS oe

[ (p) Pedit command (w5 wars) 3|

@7 sfra o e 1 Wi @fel | e offe AT Edit 1 : '

R AR ISR TG @meLinemamwmﬁPﬁnemﬁmﬁwmmmwm‘%
T | S R Betty T AR AT | 31 SRR mwﬁmw@ﬂf#ﬁmu{mﬁﬂﬁﬂﬁwm| @ offe Mg
AT awea BT 7 | A wR=rE «fEs Fas A Hatch 33T (441 |

Command : Pedit A _

Prompt : 3elect polyline

Respond : “Aff @113 ey +2

Prompt : Enter an option [oper/j oifvwidth.{editf\{ertex!ﬁtfsplinefdecurve!Ltype/undo]:

Close : (8 ¥t I PILAS T TN O Open ¥R C e G171 AT Close TR T |

Open : Close *fFETES Open T3 5 | '

Join ; R A T TEIGENE Joint T T w41 W |

Width ; Q e fren iy sndea vest /@t a4 T

L type : 12 G137t SR 31 0 |

Spline : % AZAGa 2dT @R o1 (g Twt Tife m%‘wammnwﬁﬁ—mcuﬁﬁﬁﬂmmiﬁ Spline.

Decurve : Curve 9% s 1, T Decurve

Edit vertext : U7 WES SAROTA T ¢

Move/Break/ Insert/T angen_pfw_idtthegeanexUPrevioustxit :

3.¢ e (e FAMS (Objects grouping command) 8 .

[(®) Block command (7% mu

g3z M < o A amwmsertwmamwﬂmlaasmaznf‘womecwaamtmﬁm a3fo
79| TR BEEe T IS IR | (T R B At go, s B 1 3 terf | @3l 3% aF I oo
waw@&%mmmsmmﬂm|wrm15liﬂﬁ1f¢mm;,ya?ﬁmaqwmﬂﬁmmr

AN

(#)Bathtub () Door left (" Door -

. _ fbar s 500 _
S | 2T (T @ Al ST (T, ¥, TN o) IEH IR U WS
3 | 3R Draw (W7 (¥TF Block — Make 1018 230 T3 |
=Y, IAME HZA Block L a%m@rcaﬂmmnWBlockmﬁnltlonwmaﬁml
azmﬂNamemTextmwﬁacuc«mwﬁwﬁmfﬁmmn(trﬁ:sDoor)
© | @S Base point 99 Pick Point B 7 =w gafon «mw G2fl frrs f73e wars TR @ faqrs

AqqeTS afbrE T T | '




fifom feufaf 52 (WT‘S) 3

T# Block Deﬂmtiﬂﬂ

F'rémwicb.." i
ir Douutwhthm
fl’" Create p:m!mrn blockgaurm

_D;agqmdqupmis: R
Ilnches

Destrigion’. . 7 Lt

B2 ¢ 500
8 i Sclect object IBLA 7% T T4 Object e Fers TS T |
mwmmﬁnmrmm%ﬁmﬁ@mcﬂm
Block Edit (7% 4fSo 23i) 3

@ (FTH FF FURTS 4TS Object (Single eatity) KO o | wdie g9 7Bt 3 From = 7@ o7 -

TR FEA (P WA Edit FAS 0 Explode FI16 frrs 71|

Ij) Insert command WW) 3|
mmﬁ\%mmmmﬁﬁwm|aﬂwﬁmﬂmwﬁmmmmmo
S I Insert (79 (4T Block (& 510778 3

3 | W93, Draw R¥EMA (A0 Insert block WW@“‘W

01 SN Command : Insert J

BRLET Insert TF S 37 Toifgs 77 |

5w s s.oon
(F) A% T ILHST Name Wwwm@mﬂwm|

(4) Specify on screen TS (5B IH FT IR oE B T B B Insertion point, scale Tyt
fafw2 v awa |

(A --(af) YR Mgl Lo



fafeg g3m FrC TS 04
| (") Explode command (9FHTATE FS) 8|

T4 73 7 SColfE® Object (F Block T T OWA Block L3 T4 SAMEE Object (3 SFTM ARSI Modify
2 T A | 92 T SIS Explode command TR F3LF (ST (AT | TS Modify IR o4 AR T& 391 T4 | %

Command : Explode

Menu : Modify > explode

Prompt : Seleot object

Response : Block 93 Object & Click ¥4 | <enter>

Q3 el 35 ST Modify F90S FFW 6 T | Multiline F Modify 4TS % Explode command kgl
(Sl (W AW T |

% 8 @ TR (Laycr}szﬁW@WWCﬁ @WWWWBXNM&W@T & (TR
(2T T )

wﬁrﬁrﬁﬂtﬁﬁxpmdﬁwmm‘q‘mﬁwﬁ@m R (I Width Q1T A | WG‘WW;dthmﬂTﬂl

Iﬁ W block command (38 I TUTS) sl

ﬂmﬁmiﬂwmwinw:mwﬁmmwﬁmwn :
S Wblockmwﬁﬁ\aawwﬁtwﬁm aﬁmvﬁﬁwﬁm1
3 1 TETH 3R G4 TAES TATE Delete I |

FAS § W block .

_ i3 Write Block

CBeck T T -
: (C Entire drawing
© s R
: ~ Basé painl - - : . o Objects - - e .
" {00000 7] ORetn . o
v g ] SCenvattobiock”
- b O Delete fiom drawing
0009 o .
z |U | o /T No cbiects selected -
- Destnation
* Filename and path:
EHy Documentsinew block : : \rl @ :
Ty . ingast yrits: Ilnches QI
.“ ' E oK ] r Cancei J [ Help 1

. - fBar 8 .80 Write block STITAT 39
@B : 93 Block B & B3 WIAR ITHT, WW@?@'{WWﬂTiﬁQWBIWkNW
WWWW|SaveWCﬁwwslocquﬁmﬁﬁ|



obr e fefmfie g3k (Fre)-
| (®) Divide command (fe&iRE Tu18) 3|

@ TSR TR (P TR, ﬁﬁﬁﬂmmﬁﬁiwwwm | Divide ¥ R Measure PSR
WAIRGT KT 9FR |
(b) TIE : Divide -
Prompt : Block name to insert (T3 % IS TH |)
Prompt : Align block with object :? y segment length:
. *[Ren R hs o A |
S : Divide .
Prompt : Sclect object to divide: «Number of segment> / Block : 5 J _
(b) Measure FWG : 43T MEH, T, T8 A FIN IS ATWTHR FRICG A ©1ot Btet 33 713
Commnad : Measure .- '
Prompt : Sclect object to measure
Respond : Feed 3t

Prompt : Segment length (Block)

| () Purge command (%1% 17s) 8|

A BPALS TG A7 WSTATAR/ TGS (o1ill7, T, STRTHA=I 5518%1 Jeqfre ifes 21 71 |
M’ mwamﬁwaﬁﬁwmmmmm—

31 o (MF7) I

2 | Standard text style

¥

9 | Continuous line type
Command : Purge .J

Prompt : Enter type of unused objects to purge [Blockstlmstylestaycrs!L Types----san.-
Respond : All

|(®) Xref command (THE® 1) 3]

W block FNEBE A Xref TS AN AL | ST+ Z7— ~Whlock TG T8 2wy 321 werwd To
PIRET R FTALYS 77 | g Xref TS Frw T weem wor wivema sieer o7ovred <ir |

3 WEFITFTW (Enquiry commands) 8

|(® Di

awmmmqmﬁmwmwquﬁﬁqﬂm@mﬁwq wm
LLite o . D
Comunand : Dist '
Prompt : Specify first point
Respond : (Pick a point) or point A
Promt : Specify second point
Respond : Pick another point at B
Distance = 6.9599,

Angle in Xy plane = 33 . '
Angle from Xy plane =0 D D
Delta X = ---enem-- yJDeltaY = - A B
Delta Z = 0.0000 B2 8305

ARIG!, @ FATSR HIXITWT S JTUR Center to center AT, FAE TS (72 &1 T |

C




.- fefsy a7 FG IS o®

“%fS 3 _ 1 1
Command ; dist J :

Prompt : Specify first point ' g T{e‘;
Respond : — Cen of (P} D, “t_g
Prompt : Specity second point '

Respond : — Cen of (Py)

Result : : i

Distance = 7.5326 (4f2)

Angle in XY plane =30

Angle from X} plane =0

Delta X = Autc CAD Te1%d] (A1

Delta Z = ----enmr-- _
[@) Area command (i WTG)il
Q FUCS LRT CO (T 4ETAR (G CHae] il U1 | SR (1 e fSota i) 4t § et

g <if =Rede cFamAS (39 T T
Command : AREA

A B . E
F
C D
H - G
' ' foa ¢ 3.89

Specify first corner point or [ObjecvAdd/Subtract) : PICK POINT AT A
Specify next corner point or press ENTER for total : PICK POINT ATE
Specify nex: cormer point or press ENTER for total : PICK POINT AT C
Specify next corner point or press ENTER for tatal : PICK POINT AT D
Specify next corner point or press ENTER for total ; PICK POINT ATE
Specify next corner point or press ENTER for total : PICK POINT ATF
 Specify next corner point or press ENTER for total :PICK POINT AT G
Specify next corner point or press ENTER for total ; PICK POINT AT H
Specify next corner point or press ENTER for total ; PICK POINT AT A
Specify next corner point or press ENTER for total : <ENTER>
Area = 21443. 2026, Perimeter = 728.2245
' A

femey.88



e Fafmfee w3 (Fm9)-2
Command ;: AREA
Specify first corner point or [Object/Add. Subtract] : A
Specify first corner point or [Object/Subtract] : O
(ADD mode) Select objects : PICK AT OBJECT A
Area = 37527.5584, Pertmeter = 818.4180
Total area = 37527.5584
(ADD mode) Select objects : <ENTER>
Specify first comer point or [Object/Subtract] : §
Specify first corner point or [Object/Add] : O
(SUBTRACT mode} Select objects PICK AT OBJECT B
Area - 2952.5104, Circumference = 192 6197
Total area = 34575.0480
{(SUBTRACT mode) Select objects : PICK AT OBJIECT C
i Area = 29525104, Circumference = 192 6197
Total area 31622.5375
(SUBTRACT mode) Select objects ; <ENTER »
Specify first comer point or [Object/Add: < ENTER »

' [ (™) ID command (SRS 1) 3]
|

Command : Id

Specify point : Pick a point.
Prompt : X =6.25, Y = 10.45,Z = 0.00 9 #91ts7 =00 ¢ R 7T Wit W
| (%) List command (5 FAS) 3

aiwwmmvﬁsmmmfm— (O, TR, FIZF BrEet Ty |

Command: LIST

Select objects: 1 found
! Select objects: 1 found, 2 total
| Select objects: 1 found, 3 total
|
|
|

Select objects; /_

Objoer.s

ARC -Laycr: "0" ezt - 1 i3l -2
Space: Model space _ .
Handie = 89 ' f5a s 3.8¢

center point, X = 11.6622, Y = 15.2471, Z= 0.0000
radius 4.2134 _ '
start angle  73°
end angle 178°
length 7.7014
CIRCLE Layer: "0"
Space: Model space
Handle = 8A
center point, X = 18.2100, Y = 17.0449, Z = 0.0000
radius 2.7019
circumference 16.9765
area 229342

LWPOLYLINE Layer: "0"
Space: Model space
Handle = 92 "
Open
Press ENTER to continue:



RSy aem T11e Fars 83
Constant width  0.0000

area 296670

length 22.1310
at point X = 28.0485, Y = 16.0676, Z= 0.0000
atpoint X = 343199, Y= 16.8724, Z= 0.0000
atpomnt X = 33.2843, Y= 21.4139, Z= 0.0000
atpoint X = 28.7390, Y = 22.5061. Z= 0.0000
atpomt X = 28.0485, Y= 16.0676, Z = 0.0000

3.9 A4S ¥ (Plotting commands) ¢

$RIE 4 ol T GRUAP RABT/2ABITeR A= W1TBofS s 7w A, SRR b 7 varw I Bew |
A3 (PT TG RS WEOALH AT 951 w23 )
4B TS
() e A PR AR #5152 o@r 3
> 1 Flat bed type (315 @E 513+)
R | Drum type (¥ 5137)) |
(%) Fdrafen Boxr oy wta o5 42 ey ¢
3 | Pen type plotter (19 BiZ™ 261)
2 | Inkjet type plotter (3Cerd B3 AoR) |

|(a) Layout command (F-|18T F1s) §|

(FI-STE5 0 B3 MG F2e Aterara gy | aﬁﬁa%ﬁ@ﬁ&%ﬁﬁm@@mw
@lﬁ%@ﬂmawﬁw%hﬁm@@| '

F1-WTEE BRI e e 95 s 83w fomn @mc*ﬂmfimww;w&ﬁ’rmﬁmmm
SRAHISTANT HATS T CRIA 5B 1o <afF A CHB (AT 91 AF | I AT |

T ¢

G (G 4B AT BroTem My o6 @ G .

Layout : NUS9 (™03 § 371 WIS ﬁWWﬂCﬂ%WﬁTW,@QWLayoutI

Layout 0SR% %fS 3 :

(I-SI1SE Pfey FTeIs FOPGTA 4To 9 27 | 4T &

> | BRRGTIRE AEH (AT OoTA 7 |

| ferra/ebm sl o @4t |

© | New layout farcai® o1 |

8 1 (FI-WIET 97 (e iR 2 | ’

¢ 1 997> D136 7o ZT 31 |

¥ | Floating f$® (75 2efz =21

91 View ports 43 S8 ¢F8 (315 @1 |

b | AT Layout O 45 7y |

C-WITG cofbe ¥ ¢

TS ST SBIFTICS T CFTT (S 2 3) F B2 <41 |

TR 3 :

1. AT SIS Architectural-& G5 39 |

2. Command : rectangle .J

3. Respond : Pick any point

4. Respond : @ 100/, 80" 0 -

5. Command : Zoom .J

6. Respond : 2 .J




Fifem e g3 (377%)-3
TIRLE 1:] CHEA 100" x 807 A9 HTWSTHAD FIR LAG1E &g =52 )
Layout a3 (& FOENA 32T 3

File ¢ (ATF Page setup —7TA T 90 Page sewup SIRE IH WIS TR | @ IER Sommeten fmsel-
Plot area : 95 fF% AU orafsts 0 3te T 1 147 3
() Window, : |
{%) Display.
Scale : Display A Window S#¥H-a {5 39 0991 (0 200 WITZ ¢ O GAMH (0= Y o5 w13 o
T QT | :
Plot offset : F7T8E Edge (AT X Offset, Y Offset TS 316 I3 CW?II T
I (b) View port (88 (711%) 3 _
SR oA B wTe1 @21 TR @ ST MR T (T | 3 B3 B i o8 (oniE At e
Tt ¢
Model space- A SN F68 (11 T0 TR AT A 1 View port FUCE T QTS (TS T 7N
7N AEESTE (7 (S (& (ofF BT Layout SR g wmwt 7mm

CViewports

New Viewports | Named Viewports |

Hew name:

Standard xil:Wports:l _Prwi&w :

{ *Active Model Configuration®
Single

i Twor Vertical )
(Twor  Horizortal . *Crarent* LCunent*
‘Three: Right

- Thiee: Left
‘Thiee: Abave
 Thiee: Below

- Three: Vertical

FDUI Right
Four, Left

*Current® “Currert”

Appiy ta; Setup: Lhange view to:

: Display ) i2D Vu E *Cusrent”

E" .IIIK. [ Cancel |} ]

o 2 3.8%. View port

@ (1 WP 158 (o5 ¢

> 1 (I ATRTER 8 Arpfeg warerd Tofd @9 |
‘QIViewportmﬁfﬂmwmﬂfﬁm?ﬁl
© | 99T PS IS (T ARG o @9 |



| fafg ererv FITS TS 89
[(c) Model space (&N C437) 8|

Aumcmmﬁﬂmﬁﬂﬂ\mmm T} T S o | GUECE UCS WiEFAD fAngorse
YA FE | : %

b

1‘89'\ 1OLAN

Regenerating model .
AutoCAD menu utdtlities

5@ g >.89.
E?atﬁm’ﬁw % 731 RO TRE B TG A T T |
WS 3 (1R O LB S MS IS e Wrew ¢ 75 R |

(d) Paper space (¢ C=) 8

Bifi5r 31 AR T G F1-1BB 2B IR T CHAR I | (AR T UCS SR Tirganis wieet 3 1

msmﬂmwmpsmﬁmmmﬂmﬁﬁww|cﬁwmﬁzwﬂﬁm
oI WGTIR w1 A A

B : @G -G A wﬁ?'ﬁmﬁaﬁamwﬁvﬁs@-mﬁfﬁ%wma

3. TIRGER ¥ (Dimension command) 8

mwwmmﬁﬁamﬁﬁqueﬁ&wmw]mwwmmmw\
>, fafey o= wigTe 8 |
@HWEW’Waﬁﬁmﬁmﬁmmmimmcnsmncomand 2T T G7R =TT

el 79 T W 1 WIS ﬁ‘% %303 Dimension 4% 1 T | Dimension command ST oy @ @
9T | A 8

1. Linear Dimension 2. Aligned Dimension
3. Ordinate Dimension 4. Radiai Dimension

5. Diametric Dimension : 6. Angular Dimension

7. Baseline Dimension - 8. Continuous Dimension
9, Leader Dimension 10. Tolerance...............

11. Centermark 12. Oblique

13. Align Text - . 14. Style

15. Override 16. Update.

Dimension @mwaw-ﬁmwﬁmﬁﬂwmﬁmwww 3
Extension line

¥

Exrension overdimension
line

1 004~ Dimension Text

f‘Dimens’mn line
¥4—Amow head

A Origin offset
fbms 3.8y

§\‘&\\\\\§



ol

88 fafem Bfefmif &3k (I6)-3

Dimension line : Text I “'lﬁmﬁ"f? #2CF Dimension line A |

Extension line : Extension Origin Z0S Y =191 7fb TZALE Extension Jine 97 &

Extension Origin : (& ﬁ'i (ATF Dimension SF 4| T SITF Extension origin I | ‘

Extension above Dimension line : Text §& Dimension line 93 %S W4T Extension above Dimension line I |
Dimension Text : Dimension T3 &7 (T Numeric value (o121 4T3 ©T2 Dimension Text T8 |

QIS THAMT (4, Dimension G% P WA Dimension parameter C-"fﬁ I S 77 |

2. Dimension Parameter (15 3% foaw ot 3

O Menu bar (3T Format > Dimension style select 3 |

AT, Dimension > Style Command line & DDIM T2 Enter w1 |

Dimension style dialogue box A | G419 (9T Geotnetry Dimension style dialogue box SFTR | q¥{A
Arrow head W20 Size 4 9CA 5 mm A 6mmﬁ'|‘4 I Arrow héad 4% W‘Ffﬁ B eg o 1Me 2™ Tab q B
27 A 31 QIR Extension line W4 Extension &R 5 mm. Origin offset T3 Smm 8 Overall scale WG -
1 T8 Ok click 39 1 SI=CA (M A Dimension style dialogue box SRR PR GT" | _

419 Format Tab 4 &% 3 | Format dialogue box ST (% Force lined inside click ¥, $Ta Dimension
line 71 T S 2T | i Tt T -

RUXO)

[~ Force lined inside [ ]Force lined outside
foms.8s

Format dialogue box-a% Text W™ Inside Horizontal 93 Outside Horizontal WG click 73 @ | Y S

Justification ST o Horizontal/Vertical justification button click FF Text ST T St FEHA 39 |
SYATS Centered select TR S T | Ok Click F@ Dimension style dialogue box g fow A WS
Annotation Tab @ 3% 3% 1 Annotation dialogue box WP | Annotation dialogue box 99 Text SI™¥ Height WA
(ST TRATS! Height ﬁIW 4, €3 Height = 8mm | Gap 9% Y@@ 3mm 932 Colour 9% W3 IWNCSH Colour
ford #7CS AR | Tolerance T Height = 1 P | Ok click W Dimension style dialogue box @ T3 79 | WRR
Okﬁrﬂ‘ T Drawing area ¢ O =9 |

o, Rt et erRee 5

1. LINEAR DIMENSION :
Linear Dimension % &4 Horizontal § Vertical &1 Dunensmn “’Iﬁ'ﬁﬂﬁ %9 T | Linear Dimension TR
Ty QD THEE LT A8, TRAAT—
U (@™ 9= Dimension> linear click ¥ | _
Prompt : First extension line origin or press enter to select :
- Response : Intersection snap icon fF= =@ Pl ﬁ’iﬁm )
Prompt : Second extension line origin or press enter to select.



' ffeq s 1S TS
Response : 9% amfers p, & 9 791 W cvsmmﬁfﬁww Dimension MY (71 T |

100

i
|<— 100 —~—-—>| P _ .

foas oo

- 27 ALIGNED DIMENSION :
Aligned Dimension €% AR {1 A1 Sfw (1A o112 ﬂﬁ‘ﬂT"T L1 T |
Aligned Dimension (FETA & a3 SRTEH o A1 | TRAI-
Q 31 (IS Dimension > Aligned click 39 |
Prompt : First extension line origin or press enter to select :
Response : Intersection snap icon &% 273 P, B {55 34 )
' Prompt : Second extension line origin gt press enter to select.

Response : 1% “&ers P, 7% 3% 321 o7eer, e weeei Dimension 44T 07 TIEE |

5 5 3,25

3. ORDENATE DIMENSION :
_ (I (R FAT Object Draw IR A T W ﬁ“ﬂ@ WF ordinate S SIS m “TG | ordinate P T
FEFS ¥R ordinate TS 17 | G0 =M% § 32

(J ¢ @™ (IT® Dimension > ordinale click ¥4 |

Prompt : Select feature :

Response : Snap icon €13 7wl fora Pi fvqre @W LES

Prompt : Leader endpoint (X-datumy Y-datum/ MtexV Text) :

Response : (¥ IR WG (T8 718 ORI IFR aa f7e 7911 X Wmﬁwﬁmawﬁfwm|w
Enter 519 a1 WETR TF &SN 79 39 |

Y
f

[y
¥

o g 3.2



8y _ Tafen gfgfamfae g3 (319)-3
Prompt : Select feature :
Response : Snap icon 47 TRl 7w P, feqre {32 3=
‘Prompt : Leader endpoint {X-datum/ Y-datum/ Mtext/ Text) :
Response : (8 FT7 MG (74TS 519 mmm@wfﬁwm Wwﬁmaﬁ%mt
4. RADJIAL DIMENSION :
(I Circle, Arc, Filled 23R Radial & "‘lﬁ'ﬂT“l’t’@ Radial 1 focn faefa = 3w g waTEs JArs far

TS TF TR

QO (7% (F Dimension > Radial click 99 |
Prompt : select object
* Response : Circie A-C% Click % SIZA Radius iR dimension *NGH! T | &% 930 Arc 8 Fiilet 93

TS TEHE |
O/ )

fom s v.en

5. DIAMETER :

(&M Circle, Arc, Fillet 8T object Q7 Diametric Value "'lﬁm‘“i A Ty Dlameter command ¥TEE =
= | Ry wared do ow @i w39

U o= #tF Dimension > Diameter click ¥4 i

Prompt : Select object ‘

Response : Circle B-{S Click ¥4

Prompt : Dimension line location (Metx/ text / Angle) da0
Response : (0 EH Dimension text (F¥TS 516 Ipfa i3 g9 o s

T 71 (VW Diameter (TRT TR | M TRITTST Diameter s e B
®Z T 104 Enter 517 | '
Prompt : Dimension Text < >

fBm s s.e8

*  Response : 300, 100 fTY Enter 51% | (¥ {ITF Diameter Text (RATS B8 IPT 18 7 e {3 701 oA
300 Dia—% Diameter text (T TR 4 '
6. ANGULAR :
uft MIeR Ngedf @m i v @ Il T s wfacm AT (TR 0TS Rl o 7 |
- (I (TF Dimension > Angular click ¥9 |
'Prompt : Select ar, circle, line or press Enter
‘Response : A line 4 click ¥ !
Prompt : Seiect line
Response : B line-(3 Click ¥4 |
Prompt : Dimension line location (Metxt/ text / Angle) :
Response : (U A Dimension text (4TS 519 I R A @0 1% 31 (TN Angular Text (¥ W0 |
fF (TR TR Angle F1RTS Bie B@ A Rt Enter 5171 |

Prompt : Dimension Text< >



Rfeg oFe T NS
Response : 300, 100 T Enter 519 | (¥ EIT Angular Text (F47S 518 I (73 R (AT 5 9 |

89

fow 3 b.2a
7. BASE LINE :
Base line command 791 @5 ffF8 Base ZrE WATRTET (X6 ¥F ART GO FAS AR BCA ANGT 7
BT (IH TIER I [0S 9[51 DIMDL! Command W A G0 Dimension Text TS I49 Dimension
Text 9 Vg T© LI 1 frdiet w7a fars <0 1 fB8S, Base line Command ITETER AL Linear dimension

AL IR YA Dimension oea e T ¢ “tA Base line Command TJI8E IR @& Ua 8 q&is Dimension WET;
w1y | feremm oef® ovs =9
[ ]

L

A

B .
]_{1—100—>| o
| 4 200 ——|

!- MG

fod 2 3.00

0 Command line @ DIMDLI 74 Enter 5191 4

Prompt : Dimension Text < 00.00 > :

Response : T€ 7dg 49 A Dimension text Cﬁ"ﬁ_ 5@ % 04 Bnter 5% | 49 Dimension Text (&1 TYITE
R ER L0

AW GRETE (XTD Diameter > Linear click ¥4

Prompt : First exiension line origin or press enter to sefect

Response : A f&¥7s fx& =2

Prompt : second extension line origin or press enter 10 select

Response : B ﬁ"iﬁ T

¥ TR A CATF Dimension > buse line click T4

Prompt : Specify a second extension line origin (Undo/ < select >)

Response : C 7t &% @9 | 20 mm T Dimension Text f§ “item ara |

Prompt ; second extension line origin or press center o select.

Response : D &90% f&s &2 20 mm 05 Dimension Text 5 *s@ W | QO aFihe 7 “117
Dimension (778 A1F | GIW Enter (017 T (14 o9

8. CONTINUE

Continue command f3 Base line Command 99 SIgH | Sl s wF @, 9Bt ﬁﬁﬁﬂ"’{ .Tz": ez @i ‘T&C‘Wﬂ
wdie, Base line £% % 493 Base line T0E 7 2w oF g =1 09 Baadif orF & |

. T ——

A B o > k F
| 4= 00— 1 50— | e 100 = = 100 —p} e [ 00—
Litear ‘

fodzs.ea



Tfom Hafemia: g8 (3718 )-2

Q) (=214 (L& Dimension > Linear click 79 |
Prompt : First extension Line origin or press enter to select
Response : A R=re fFa 24
Prompt ; Second extension line origin or press enter 1o select
Response : B 7% Click @7
G TS (W4 (ATF Dimension > Continue click &9 1
Prompt : Specify a second extension iine origin (Undof < Select >
Response : C f5Ts fpa 29
Prompt : Specify a second extension fine vrigin (Undo / = select >
Response : D (S 3% 391 0o "fiuw@ k. ¢ fare @% 3= 1 o127 918 Dimensoin Text 78
CRRIZF SR AFCS AT | 9R Enter (5791 (RN T7H (418 3%

9. LEADER : .

FIFS TG G WS (FW (4% 91 SIS fifes ware @ B wg oa oy Fure 9 e Seedl =
W fafa 2R 7=e 1w o I Leader Command 79T 31 7 1 farpe 55 oo wg

R 10%20

HL 2 5.0y
O (=741 (ALF Dimension > Leader click 32 |
Prompt : From point
Response : (7 SRCTHT M6/ FCE 519 WE 60 G18 Wi (o famre form 2
Prompt : To point
Response : Extension line {3 (0 ¥R 71(% <7< 516 T8 Ftra (R FA o w9

Prompt : To point (Format Annotation/ Undo < Annotation =

Response : Enter 5191

Prompt ; Annotation (Or press Enter for option)

Response : Enter 574

Prompt : Tolerance/ CopyBIockJ None/ < mtext »

Response * WRT Enter 519 | Muitiline text Lditor Box WA £¥ts ¥ T ve ¥ AR ok B w9
(AR~ (ST (73 W WS 0% |

10. TOLERANCE : ............... ST

11. CENTER MARK :
TS (FG (W TS N AR WGE 7 O @G A Center 5753 Twa 2Tw T AS R 48 Center

ffee =am M2 Center murk command B 27w o 2 Center mark vommand 270752 %74 Dimensions stylg >

Geormetry > center > size —— 4 mm



Rfeq 2R ITE AT _ . 8%
[ @R (4TF Dimension > Center mark Select 9 |

Prompt : Select Arc or Circle
Response : (7 98 I WE Center 8 3T B10 B sfifirs e @@ o fFe @9 S 8 A W E
: 5]

] A wis 2R |
S

&
@

BEss.as

12. OBLIGUE COMMAND : . _
o4 7% %91 ¥ Horizontal I Vertical Dimension line (5 T 8w #0a (AT 15 S 518 LA

OT% GG Obligue TS AR 33T T 1 fes foufl o1 22

" 150 b/ 150

fom 2 500
[ (999 (AT Dimension > Obligue Select T4 |

Prompt : Select Object .

Response : £¥ ¢ Dimension line AR T (FID TS B AGTERA TAR TEH AT (A oo o3 92
THIGETH TS ' '

Prompt : Enter Obliguing angle (Press Enter for none)

Response : Dimension line B we fEfll (Tt TS I8 AT AREM &6 o @Bm B9 1 6% wo el |
i STCATS (TR Dimension tine 5 wo fla i SEH TR | '

13. ALIGN TEXT:

Dimension 3R sy YT Text &1 T | TYNE F Center-¥, FUAG IMT SR A1 Align Text
command F% (PRI TGS QTS IFFM TS SATEH ARTEH 71 W |

[ WS 4T3 Dimension > Align text > Home a3

Prampt : Select dimension ' :

Response : Text 93 %% Cursar (R 5 7| (AVTA Text & Extension line & move A" | (ST

BRAT L IS Move $ANS (¥, BRA (I (5TA Text Bt =6 T=Te #A
. W9 Dimension > Align text > Angle e

Prompt : Sclection dimension ' :
Response : (3 Text {63 TS 516 ST BA WA #rFor @ 9 9, (MW Text I Extension line 7%

TLHT TR G332 move AR |

Prompt : Enter text Angle : :
Response : 45 o 10X Enter B1%1 | (19T text 6 AR 20w 45 foftl comeet g Frev ¢

WA, Menu I3 (& Dimension > Align text > Left 6 5% 7 |



¢o fifem Bffmfae g2 (wro)-2
Prompt : Select dimension
Response : 1% text 5 Right position f6ea1 Center @ A1 B Text 9% BF Cursor &0 Enter press &40
e Text 5 tefe Alignment 3 left position & BTH WA |
IR Dimension > Align text > Right f&s 77
Prompt : Select dimension
Response : W Text B lefi position [ center @ wra wra Text 93 A Cursor (32 Enter press T afe
Right Alignment 31 Right position @ 578 w57 |
STAM Dimenston > Align text > Center fFz 7,
Prompt ; Select dimension
Response : ¥ Text 5 1ot position f@ear Right Position @ ¥I® ®7R Text -9 513 Cursor (A Enter press
a7t afS Center Alignment 31 Center position ¥ 5T ST | I
[0 Command line & DIMCLRE forda @unsf anfed w vy |
14. DIMENSION STYLE :
Dimension edit T4 ATTEH T Dimension edit R 9048 Dimension style G376 7 fars 7w
[0 Menu bar (973 Format > Dimension style select T | WX Command line @ DDIM oz Cnter M4 |
Dimension style dialogue box ST Fig (225/sha) | 94R TP Geometry Tab @ click | ®Tgm Geomeury
dialogue box SR | IR Arrow head SRTT Size &% WTa 5mm 31 6mm B47 | Arrow head @z WIS A 77 w19
T 18 2 Tab @ e 3R Mdea 43R Extension line W Extension R 5 mm. Origin offset T 5smm
'S Overalt scale W28 | T3 Ok Click 9% | SR (727 WA Dimension style dialogue box SR firz wrg | '
SRR Format Tab & f#® ¥2 1 Formar dialogue box WTHT | '
Format dialogue box 913 Text W¢™ [nside horizontal R Outside horizontal W Click A (79 | 35 SreaT
A9TET ¥ 1 WA Justification WerH frgy Horizontal/Vertical justification bution click 3@ Text o2 TN T
{69 T4 1 AgRTS Centered select A S TH | Ok click ¥ Dimension style dialogue box @ 3 T,
Annotation Tab @ f&® ¥4 | Annotation dialogue box WALT | Annotation dialogue box a7 Text S Height T
CTTAT8 TR Height fT8 03, ¥ Height = $mm | Gap 9% 91 3mm 93¢ Color 93 WA TRINTS! Color fadme
FAE AR Tolerance TR Height = 1 719 1 Ok click I Dimension style dialogue box « 2 g | w1 Ok T
T Drawing area ¢ Toogg w1 |
15. OVER RIDE ;

"[C'f Lincar Dimension (7H! 9TATE LA 1 9% Command <3 AT Dimension 43 Style change 31 19 |
Dimension > override

P’rompt : Dimension variable to override (or clear to remove overrides)

Response : dimtext

Prompt : new value (10);

Response ; 20

Prompt : dimension variable to override

Prompt : select object

Response : WIBH g1 TR object select IH text 20 TH |

16. UPDATE

e T B White colour select #78 Dimension €3 TR TR AT 93 TEAA ©1 AA%T IR Red color G2
T TG TS P TR W A White color BE Red color-a RAES ware oM+ e aursh

AP ¥ t Update IS5 T4 S 97 (A0 1 dimension > update WRTA Text 10 2%7 |
Prompt : select object
Response ; Object select 3R Text ofRea o7 |



£y €23 FHT TS ' @d

[ Dimension > Update
Prompt : Select object

Response : TarERrE Object 6 FAS T 1 SR (B warersl Update TR
294f¥%% Dimension command ST Qg9 JRS f&g Dimension Command & %A Command Jine & foTCd |
= Dimension style (4IP3 i S IR RS DD DIMEXO, DIMEXE , DIMCLRE, DIMDLE. DIMBLK.

NEWTEXT. DIMAKLTD. DIMDLI, DIMGAP, DIMPOST el
DIMEXO {Extension line offset ):

Extension line 8 Dimension Extension line origin <3 TSl Y We SACED (ATF Extension line for Wy

gDl B YA <] LTS §

DIMEXG Command s «f 231 7w 1 a6 wigrs Dimension Style reg OfS ser F TR

[J-Command line ¥ Dimexo T4 Enter 519
Prompt ; New value for dimexo < 0.6250 >
Response : 10 T2 Enter 3™

DIMEXE {Extension line Extend) :

Dismensjon line (4T% Extension line ¥YEF G YR ©1 DIMEXE Command T farae Ta1 WE

[ Command tine @ DIMEXE T2 Enter 5191 1
Prompt : New value for DIMEXE < >
Response : 20 fer™ Enter 5191 |

DIMCLRE (Dimension Extension line color) :

Dimension Extension line color 9% FETY Extension line a7 Color &SR T4 T ; 9 Color 94 ¥ 7

(T8 72 Command line @ T TS =W
— C.mmand line @ DIMECLRE ford Enter 9171
Prompt : New rajue for DIMECLRE< >

Response ; 3 T7X Enter 51 | STRLA = 208 Extension line *16% T |

DIMDLE

Simersian Nock TXF ST = (40F T 3 9rF ©< DIMDLE {32 78 | e SArRaTare 3w B2\

DIMBLK Command :

FTREE Dunension line 0 Arrow 5% F5s169 o741 T | g 2R T A T T/ IS 518 IR Dimblk
command SR FTK ATT *F WA (WA (AF Dimension > Style IR Geometry tab -4 f#F% 37 SR
Artow heads push button box @ fF® =7 Box select ¥ | S Arrow 94 AfFaTE Box T |

[ Command line @ DIMGAP Command & T2 Enter 5171 |
Prompt : New value for DIMGAP < 00.00 >

Response : 10 foTd Enter 5171 e ARRE T =
NEWTEXT :

¥ Dimension Text (21 ¥4 26uR o T 46 JRT¥ Change FI ferere ¥, (UL Newtext Command

% 479%IR T TW ;

™ Comsmand 3% Dim {104 Enter 5191 |

Prompt : Dim :

Response : Newtext T Enter 3191

Prompt : Dimension text < 0,000 >

Response : 240.94 < Enter > o2 511

Prompt : Select object < Enter >

Response : 8 (4 Dimension Text AfaSq TATS B18 (G
AfaarE FS{FTE (FH1 Tg= Dimension Text (71 TR |

TR e 31 | wEA ‘F[Cﬂ”sl Dimension Text-99

LN,



£

&
DIMALTD
Text (T4 FTY Text

d foifem Rfafmnfae g2 (Fm6)-2

€7 TR T T @ S 7@ 93 DIMALTD command %37 af6 fefy 320 319 ot

¥l Dimension style (4TF Annotation @b click 3 Annotation dialogue box W 2 Units tab-9 3@ wars
Primary unit dialogue box WY | @41 (/7% Precision push button- 5 I3 e R TS W TS B9
TG T3 U | Q49 Dimension FI0 ¢ ! AN | Precision = 0.00.

O Command &R DIMALTD et Enter 5191

Prompt : New value for DIMALTD < 2 >

Response : TITA *i7 ¥© w3 e B18 w1 oy Enter 519

DIMDLE :

PRS0 (1 (G TRAN TR T T O TS a3 o1 il (s o1 § 1 @ aae e
SR @ Ty 9 AR g Ter s | DIMDLI ¥41E qret q% A waqrss frwgq 12w |

O Command line @ DIMDLI Command f&f5% forx Enter 519 ' .

Prompt : New value for DIMDLI < 00.00 :

Response : 10 e Enter 519 9% ARRES o 3T |

DIMGAP :
Dimension line 93¢
T Y | '

Dimension text 99 W] FERT AG A O 1B IS Tt frmEe 33t TN s Bafe

O Command line & DIMGAP Command 5 74 Enter tot I
Prompt : New value for DIMGAP < 00.00 »
Response ; 10 T4 Enter 519 a3 ’lﬁ?‘fﬂ T |

DIMPOST :

Dimension text @M 7w % @7 aw3w wifeg iz Wi F. Inc, mm, cm (R LTAEH TU RO~
DIMPOST 1S 3% TF | : '

53 f5uf = 3

CCommand line @ DIMPOST Command {6 e Enter 1%

Prompt. New value for DIMPOST, or, for hone < * “=

Response : (7 43 fo19TS 51e W7 fE10R Enter 5191 G4 ARR<H 7% w3 |

8. Dimension 51%e 516 =4t §

A

prmem e = ram e

¥ O8A Nsz@@A.&H%LWs
52 3 363 ST form

Dimension CiIq (V% Style ............. @ B8 T Dimension style TR I8 ST |

foa s 502 (3)



<% 7% /TP [ Modify .| 0T 35 0 modify dimension style BT T T 2 |

b g 5.22 (¥) Modify SEG=R BEa
9%, ACHA Line and Arrows IR {&5@ SR Arrows size 9% & O W s 73 | (qR =47
Text B {55 BT Text height 92 WA ARAER I &3 T 1 (44 - 67) awwc\sﬁrmmw
e/ Bz = fres e

Primary units BT & Architectural A (SFw guiiw a9 0 TR | O OUF Architectural 4T
s e TR |

4z B3 cffis rafers §3 TACC LA Metric/Decimal BTEB Sclect TRCO TT WA oA ‘SIT?N?W
fafa/cafir @ Forea a2 e T |

W Dimension text
/ ———Dimension fine
i 74 »| Extension line
Extension L[" z ension [y
ofiset

N
b;/—a.s——-{ //
/////4 N

Horizontal Dimension

f—- 2.75—!1

Vertical Dimension

Aligned dimension Romted dimension i

F—1.5—*-—2.2—T72.0—1

Continuous dimension

T —— e ————————



@8 w2 g% (IT)
- .0

6

Base line dimension

Angular dimension

5 | Dimension origin : (¥ %6 %53 w19 At o |

R 1 Extension line : SI&T= Sfifém waiag o1 7% =13w 511 oy e Extension line 9% |

© | Dimension text : 7 Extension line (& T& A (T 7118 § 31 TF O Dimension line 9T# |

8 | Dimension text : Dimension ®&TN (4 W% 11 T O Dimension text 37 |

CIRTR 5127 R A0 BRI ¢ .

B 97 SRUEE AR Dimension (F GBI 747 T 1 o7 e A S e RSy Sy et
HTR ST 30T 7Y | '

T&f® 3

Dimension GV style ............ (¥ P 08 modify ... 2169 25 290 cv wrarerst o2 i etz T ¥ B
T 51 - o _

3 | Lines and Arrows B9 § Dimension line, Extension line, Arrow head ReHWta @ Bl ARICy 78 221 Lyl

L Text B3 3 ' ' -




© | Fit BJ $§ Text placement, Dimension scale 3@TW 76 Tt T 4

et

n didlogue 703 T foa emiife 2w ¢

8 | Primary units BT 2 Primary units tab-4 click ¥ Modify Dimensio

Lt aevlteovs] Towr | Fi $rwvaty ke | Abarate Urts | Telsranowe .
| Ui v

[m”
. Fusgis .
Echﬁn’nrumut e 1k -]
[FFemn =]

; =l
o .

Dol o000 Bl

. Roamick

b

. . .Saa>w¢
43 BT AEW TIBLITTAL Units (18 31 T |
3.5 freralie IS (Geometric Command) 8

3 | Donut & 3 8 _

Donut TH0ST FATZTL «=fh fers e AT & T 5 G 39 TW | Donut FITE ATATIN S Fill TS

oo WS TGH TS | :
SOLID COMMAND @9 RGN 8

55T Command A7 AN NG S415 IS WaCs A | (AR WIS TA Fill Off feat ON & 41 Solid
“ e rmand 49 7N Point Selection 93 IR TR CAATE ARTS TR (W AR sifeed 7, a7 TS T |

- mmand line & Fill T8 @B 019
Prompt : F:11 On Off {on]

Response : On 7% £57F 519
Prompt : F:1. 01

Command a2 £ $001d @0 GBTR I
Prompt : Firs: poime

Response : 100, 100

Prompt : Second peint

Response : 130, 100

Prompt ; Third point

Response : 100, 50

Prompt ; Fourth point

Response : 150, 50

Prompt : Third point

Response : < Enter > Fill 50 unit square.
A Command line solid [Fill Off]
Prompt : First point

Response : 200, 200

Prompt : Second point

Response : 250, 200

Prompt : Third Point

Response : 200, 150

Prompt ; Fourth Point

Response : 250, 150

Prompt : Third point

Response : < enter > Closc 50 unit square

ne £

B2 2 .00



. fofeer fafnfe w22 (@ro)-a
43D Square @7 W U Gar SEE BT TS 27t fAesa @S wis |
Command line (973 : solid [fill OFf]

Prompt ; First Point '

Response : 260, 130

Prempt : Second Point

Response : 340, 130

Prompt : Third Point

.Response : 260, 60

Prompt : Fourth Point

Response : < enter >

94T CTHTS *ANT 9B Square O WES T g7 s BB Ty |

. feae s e . :
View (T (40 Zoom WA 53 a2 aaﬁﬁawﬁﬁwwmﬁmmwm|

den:t

= Tocks.,.

foa g 5."-10. Ei‘i’ [OF |
3,50 T a3 GHB IS (Hatch and text command) §

d. TIv TR ATASTS (The necessity of hatch) 8 _
m@anwmﬁ@mmmme|m~mﬁvﬁ,m
Foreen Teonfi 1 @ W i afes st _
. R Hatch 3% 47 “%f® 3 :
A FAEH AR (FIF object-a4 AT €T 7o ¢t 1y |
IS 70 ¢
> i Draw (T (4T3 Hatch ............. . Ped v
2 | Draw F#MH Hatch .......... ST 50 o0 |
ELTH :
2 | I MR Hatch orox «@51g a7 |-

_—




fafen aor w51e TS ¢q
Boundary Hatch @RE QI Pattern ... Mo 7 = ﬁfz‘n’ AR 6 “HIOH X T “Mhew
LY | &3 Frees FieTd 9739 99 Object & DL 351 W |
- - Hatch Pattern Palerte T ; I %

AR-BEIG

#Hatch PatlemPalel‘.te C

mst‘ ||so |0tha|Prad=Frnd]Cudmni _

7 ” %

ANSI32 ANEIZ3 ANSI34

i 3 o
y 7 it
7 f @ LE3%

ANSI3S ANSIZ6 ANSIZT AMSI38

B3

I
ARBRELM  ARBRSTD . AR.COMC

ARHBDNE AR-PARGT  AR-RROOF  AR-ASHEE

22

ARSAND-

B85 592 (a)

MubsT HET

|

BASTONE

68 O

Davze COLMiT Dot PLASTH SACMCR
B
2
EECHER ?EEX GRASS STEEi.. SwiaMP
POGRMEL (1[4 HOKEY
[al8 . C«-wi -
T § 5.9 {C) foas s.a3 (d)

®. Object (3 Wb TR RSy 3wrs 3

(A SRS 5% WH&WWWWWWI&QWWWWWWI
Fyywagfes
aﬂ'ﬁf—csobjemw%mﬁm!ﬂﬁ:mQﬂmwﬁmwﬁswww\

Command : Hatch

Specify a scale for the pattern < 1.0000> :

Respond : . (for default value) ///
Respond :

Prompt : Select ohject f5@ 2 3.9%

Prompt : Enter a patiern name or [?solid/ user /
defined] < current > /
Respond ; ANS[31- (¥73 fFmm) /
Prompt : Spccify an angle for the pattern <0 > ;
Respond : W‘fﬁﬂt@fﬁwﬁtﬁﬂwm | aﬂvﬁ B (BT P O TS A |




forfem ¥fafmtie 522 (39r8)-3
(%) R *&fE ¢
&Y Draw (9 (4T Hatch (F T8 0TS T4 |
e,
Command : bh I : ' : .
ST Boundary hatch G5 T WA | @ QHA Pattern I 38 gzl B (¥R Brick) B3

() oN G 5 - .

@ FETS (U (I TN FSTAI! (470e (3 3201 B2 T | 1 T G5 Point method I |
Command : hatch .1

Prompt : Enter a pattern name or [?/ solid/ User defined’ < current >
Respond : U o '

Prompt : Specify angle for crosshatch lines < 0> ;

Respond : .1 '

Prompt : Double hatch area? < yes/ no > <Y ;

Respond ; - .

Prompt : Select object

Respond : . (CTTP object F=8 372 711 1)

Prompt : Retwin poly line boundary < yes/ no > < N> :

Respend :

Prompt : Specify start point

Respond : (0 (F1% Rars Wies 7w

Prompt : Specify next point or [Arc / Close/ Length/ Undo]:

P, = First poing
p,= 2nd point
py= 31d point

p,= 4th point

£ = clusc

5w g 3,90

Respond : {¥ ﬁ‘ﬂ@ WG
"~ Prompt : ]
Respond : o7 e WiSw 3
Prompt : i
Respond : C J (for closed area)
Prompt : Specify start point for new boundary or < apply hatch> :
Respond :

izt oS 4 vt ovafbre s o 7@ |



frs

=

M2 ST TREBT Edit R |

fifen avm Fyre TS @

Advanced hatch : : _ -
Draw (T3 (A% Hatch ........ (¥ B8 909 Boundary hatch SRIFEst 3% SIPICA | @3 a0AF Advanced BT

e oz o= wis Style *ihewm TR | T2~

5 | Normal hatch (@91 %16)

X | Outer hatch (W85 &7I5)

© | Ignore hatch (}M73 1) |

oo fvam wnaTy ffey E 3BIEW AT -

)

K
*

O
X0 ‘.0’0
S50 -‘0.0
%Y oy
2% d0
e .0
r.t.‘
> e
0.0
Normal style " Qutar style - Ignore style
fBaey.a8 ()

Aswmciative I '8 Non-associative 5 §

Boundary ZT6 S J0H Composition 3 5 95 worier azamg | -
Associative ZJTE 49R '

(Y
-

% . Non-associative I | : _
wrEfrabs g Aesll Afd e give rrited 7@ wdie 47T w1 wwheE w-anEbats
SareHs ATTR TR Tae WIS ARRET T A A Weres 7w A -
wir TS T s@ends wlwin Sew frsata w1

Hatch Edit : %% 2o/ 37 Hatching (3 S4= %8) Seuiil Edie 340 “/1at 91 | (7~ Haich Pattern, Scale T3
Command line : Hatchedit

Menu : Modify > object > hatch.

Prompt : Select hatch object

Response : [HRE B 5% 33

Hatchedit dialégue T3 WA |

Pattern @ % 312 fAfiT8 A0 Select 21 ok 9 39 Apply T3 =11 ararem

T Scale select FA ﬁTN :



b0 ' o Tofem et g (Ie)-2
8, (BTBT 35187 (Style of text) 8

538 T B30 AW, WETHIA2 7N, *sﬁwiwnﬁcﬂwwnwezmmmwmdam—mw
o il QTR TS et T | | 9FAR Text @THE TFH—
U o718 F3A Text 018 ffre 73 |
0 7231 Draw GI (ATF Text ¢ Frerd s =1 |
Dﬁr\mTextwﬁvﬁmm%mmTextmwﬁmmmﬁﬁmﬁmuxmﬁm
ST | S9! Text OB oD (o1l WA | v 7B srafe wawrrs a1 T |

(F) IS =R Text By iﬂ%mﬂ"‘l’tﬁ&nglelme text miwmﬁfﬁﬂ o7 O 9T qEE I |
OB 0 TR 3T e T

() Draw (I (4T Text — Multiline text P T8 T 1 3718 NI meext FI 997 51978 muliiline
text T3, ¥l text GEHT GRS LI YT 4TS X7 |

fa g 5.9e

(%) Single line text ;

Command : Text . _

Prompt : Specify start point of text:

Respond : (T g (/T3 R OF TR (7 Yo 935 Fvqre T |

Prompt : Current text style < standard >

Respond : .

Text height : J

Rotation angle <0 > : J

Text : Civil Engineering Drawing .

Text :

(%) Draw G T Text — Mulnlme Text (¥ P13 T4 Multitine Text Editor WP’ @ oty arew
SHFART AR Text Size, foni, symbol 2T @R T (A Pt 9 W | fm TARee 8 BT
R -

st. Rod .
16 mm$@ 250c/c

T . foa s 5.9 .
TR AR TP (T, Text 9% IR Layer- (XT3 WPTA | WHR Text GTAR (ATH §PTE | S Text GTAIE T
IR (AT AP Text AR R € & T ewfae z= |
Text = qfeh 31 ¢ :
ModlfymcmText@ﬁm%wmﬁmﬂMW|awm%nwa@?mmw
ﬁrﬂ%mm|WEdnTextWﬁww|mmTenaf%Eww|



fafoq o= FIE FUG Uy
¢. TEXT DRAW COMMAND ({80 § ¥316) §
0 (T €A AR Text command a1 3w a1 = 1 (X =W, w7, e, efﬁ‘céwm&ﬁrﬂaaa =15
N THLM-GT ST Text command W31 7= 3301 70 | ®32 W3 (7 (@1 TR Text G131 TR | (%'
G (4TF : Draw > text > single line text )
Prompt : Dtext/ justify/ < start point > ;
Response ¢ 532 A3 (T (I ST s 33
Prompt : height
Response : 10
Prempt : Angle <0>
Response : 0 (305 3T rotation angle (¥ T 1)
Prompt : Text
Response : SMART COMPUTER TRAINING INSTITUTE (12 TR IBR ) T oM mﬁaﬁvm |
Start point-&¥% #f4aCE T Justify option use T WA Align/ Auter! FitMid/Te/ Bt X1 option T4 | fAes
2 o R
31 Align option ¥ AR TR 7 A0S W8 I W3 g Text fRTS *17 | C‘ITF?FEW 16 FATA
(TSR Text 9T height, A=EST AfTS F70 | (FH {AG 76 FWR R Text TR TH TIA qBE B | SRR
Text (FIAT JOATE |
3 | Fit option 3 Align option % ¥ & =91 TR | WA BTt Text 93 @Eb'(ﬂ Fe @ o fars 7w ffeR
Height @3 2TAEH T4 1
@ | Middle point justification option f& f9 Horizontal 8 Vertical 7Y F¥ IS AT |
[ Menu Draw > Text > single line lext .
Prompt : Dtext/ justify/ Style/ < Start point >:
Response : justify
Prompt : Align/ Fit/ Center/ Middle/ Right/ Left/ TV Te/ Tr/ Ml Mc/Mr/BI/Be/Br
Response : R
Prompt : End point !
Response : Click any point
Prompt : Height
Response : 20
Prompt : Rotatien
Response : 0
Text : AutoCAD (73R T W16)
BEA TAFAS Right adjustment ROLR |
[ ¥ 4TS Draw > Text > Multitext
Prompt : Specify first corner
Resp'onse:’r‘fm (W S 2 T2
Prompt : Specify second corner
Respbnse : i W8 g e
Prompt : Multiline text editor dialogue box W |
9L (TR (TR et fAca
B! ST e | AR (AT (T W (TR Text aaﬁﬁa ARTER 70T AR
STBRIITER S1fFE R 52 @R GAD ot T | qWi-
(%) Single line text,
(¥) Multilinc text.



- frfew 3fafmife Bk (Tiw)-2 |
Stylemmiwmﬁﬁawmﬁmﬁ#ﬁaﬁﬁaw L AT A |

'f‘ Il 151 e

D o ]

5.5 WBIHTE fewi&T GIBR (Auto CAD design center) 8

[3. Use of Symbol library 217 3524 3
] WIS Design center 3

AutoCAD Design Center BZTSIS Explorer €93 T | GH (¥ (IR 3L FIIOCE 70 997 A4 | O1aorg @
ﬂ'ﬁﬁcwmsﬁt%mmw (IR, a@amﬁwwﬁwwmm;

i

=
B
-

xr
'
P
i
1

a

oafs 3

(¥) fEwiEn GToR W3R 3% 701 |
(ﬂ)wm@i‘ﬁmmcmﬁw|
3 1 Command : ADC _

ST AutoCAD Design Center SR I SR | @ 9034 Load ?TITF{ fes TS T
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3¢ | Linear Dimension #SIE gre T - _ . [«=fER-200y)

Dimension (3 (¥TF Linear (3 5019 33 |
3 | Copy, offset, move 8 rotate command TR AR B T |
(5w f) copy : @ w1 mmmmmw 4T fored w7t T |
Offset : %WWWW\ _
Move : SRCIT® €3 W (AT S e ZIISa 1 11|
Rotate : (I19 SRSE WHE (e amar g | - o
31 Auto-CAD-o SUITSETTHEY 3 Fdidt qrvemt 9t Sty [Rferat-2100e]

Decimal, Engineering, Architectural, Scientific.
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CAD-4 FS1T BT (M Unit TR Area 3% 31 T0? [AFRIEr-2008]
Command window-C® Units (0% =43} Format (% (4T Units select I TARAT Units G5
0 70 | T Units setup dialogue box (& T~ %

Command window-(® Limits i ; EHET Bk IR o9 STeWE S
5% TR limits TS AT lower left corner 9% upper nght corner 5% F1TF |
t WBTHS Array FUCSE MR 5 b =ARHE 03 A 15 LR o B S e A
L2 B aefitat-ac0u, yo)

00
ﬂﬁm 8 5m =500 cm; No. ofcolurnn=5—5+ 1 =35 Nos.

Decimal @ unit (A0 FTA AYTW start bar G hanger bar BT I I Y AT 5171 wew 3fa | IR
e wivtort s ofE 3

Command : Array .4

Select object : FoR1G e Fare 7R |

Enter the type of amray {Rectangular/polar] : R.J
Enter number of row (-—=«=esees y<l=: 14

Enter nurmber of columns (-------vun 1<l>: 354
Distance between row or specify unit cell (---—--- Yy J
Distance between columns (-----) : 15 J

awﬁt}nft‘smmmﬁﬁmmm|

¢~ 15cm efc

CAD ¢ 7imiey ¥eig 375 it s zmr [AfEra-yo0b, 3(R)

(z==fJ) cap o zws 7 2o «

S| 9T (¥ (FF QT SRes W I G TS |

} | WRI%A Draw (7% (93 Block — Make fiT18 #3908 304 | -
- SR, IS T3 Block Prd a%ﬁﬂmmlﬁlwmmocmcﬁmuonmmwﬁmﬁwm|
Q1T Name 9% Text 0K FF0A & FH aﬁw’ﬁmﬁwm | (%1 ¢ Door)

® | @SR Base point @3 Pick Point AT fF 73 gafdn aws aﬁﬁw@ﬁwmmﬁw
TS BT T TR

8 | Select object ABTA fFa IR Foopef Objectﬁwﬁrm'imm I

¢ | Sizra 7 SATEIT Door ANE J0E FSRAS 70w (o7
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51 CAD 9 Layer $roa 9 a1 xar , - [AretfEl-2008]
Command window-(S Layer type ¥LF 9B 19T 1 Format e (T Layer select A Layer

properties Manager dialogue box IR | CRlC| Ne\.@' Layer @ (5091 Layer &3 94, #3 5139, SIEE, Line
weighf 23 €T S CAD @ Layer AR MY

331 Auto CAD-4 BER WCCIT SIRTM= oz fim fire | ' [#ifa-3004)
FH SIS § +=1 o7 gqft A | STHRW T AT | Dimension command TAN K

T ARCAR 1% srm <1 2 | BT (AR €T Dimension T 391 T8 | Dimension command
ST B TR T A 8

[. Linear Dimension 2. Aligned Dimension
3. Ordinate Dimension _ 4. Radial Dimensioa
3. Diametric Dimension 6. Angular Dimension
7. Baseline Dimension 8. Continucus Dimension
9. Leader Dimension 10. Tolerance .............. .
L1, Centermark o 12. Oblique
13. Aliga Text . 14, Sryle
15. Override 16. Update. - o
S| IDRIIS-q fre T o e toR i fird | [RrEf-3004)

A9 Auto CAD U1 T4 File G (03 New Click 901 Startup STHIFIF I8 9L 209 | G91Cw
bR SRS AT, ¥ VKT Star from scratch 93 Default unit settings ¥ILS TI | SRAT use a template
S AREA & emplate IJITT F1 (TS A | A% use a wizard (¥F Advanced set up-9 ew erarsEm
Units, Angle, Angle measure, Angle direction, area TSI (36 Wte| Feq Page set up W"’i‘f.m T
AT file G (4T Save As .......... option @ Tea Féifrs gt faner =i omant ceesii oo TS A |
31 3 x5 R e o coum ool 3R« Absolute co-ordinate S gAIwaT fre |
' [ArfiTat-2o0q, 2035 (41R)]

Absolute co-ordinate-9 = ﬁ“i (0,0) AT ﬁ?{‘mw T | A 0,0) (ATE TR T T4
A weeR ot s 9 p, (2, 2) T, R WA ISR T Absolute co-ordinate systern-«

foreg cratrtt =
. ' .0} '
k01 il B WA Freng P Ty | [Af1-2004]
(B f]) @ wicss s @ wwws @l B g o T __ |
A | _ A
Py P2

MLTER

Modify G CATF Capy f51Ter8 3, w1 w1 =118 Copy e @B |

Select objects : A IEIHT U I qA TR, _

Specify base point or displacement : (I #4005 BT 1 i «3f5 fg B == (R p)) )
Specity second point or displacement : 4fd P, | ©1H P, ﬁ"IN A wRErah % o e |
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‘Auto CAD-€ i€ W% < Crank bar @7 vewt FSR AP THH? [AriféTat-2004]

4f¥, Auto CAD-& Polyline ftx wf&® «afb Crank bar IR T o@! qETs T ) a7 &) fAoga
ereTE e 3

Command : Pedit/pe

Prompt : select polyline

Response : Crank barlv 118 20T T3

Prompt : Enter an option [close/join/width 1:

Response ;W T @B BiviTe Ta

Prompt - Specify new width for all segments :

i(esponse . SRS FAGR TR 4R 5P [T

Prompt : Enter an option [close/join/width .......... 1!

Response : x 7102 @17 9T polyline Edit option (4T3 Gﬁl’l’.‘ﬂ TS WAL

Auto CAD-4 ST Scale ¥ 9 Scale-a Foid ARTE Fae @i? - [aretfi-z0e4l
Scale FTALE] FWCW (T (D9 objects ﬂﬁﬁﬁﬁxtﬂﬂly@?ﬂﬁf@@?aﬁwml Auto CAD

o FFS T fFE Scale faad 17 T fga qorets wme 24

Command : Scale/sc .

Frompt : Select objects

Response : (¥ Object=(T %9 FACS T ©F select I <A TATS (A |
Prompt ; Specify base point.

Response : Object 9% B (A (FH AFT base point 47 T Click FATS T |
Prompt : Specity scale factor or[copy/Reference] <--—m--->:

Response . 3 oY @B BI°TS T | 997 ObjectD e 20w W)

MWWCOMWMW! : : B [arifEical-200Y]
Maywmaﬁmwﬁac@ywm '

Command : Array

Select object : (8 ObjectBTE Ff4 TaTe T2 o FeAd F0e WA |

Enter the type of Array [Reclangular/polar] <R>:R 4

Enter tiumber of row : 4 '

Enter number of coltumns ;.5 .J

Distance between row or specify unit cefl : 1.25 2

Distance between columns : 1.25 .1

SIS, CJ(f&F Copy TH A | '

1= A CFTH Hatch FONI A7 P 70y [FFfTa-200t, So(*if)]
e, @TGT TRCHG "Hatch" (IR Command 01 e | [AEfER-205¢]

Draw (¥ 31 Draw PFRIR TS WEFH click I3 T IR A Harch Tt @ OR 31 |

WI949 Dialog Box 209 pattern select T8 pick point cllck P9 object select FUF Enter BIHTS A |
Command : Hatch 4

Prompt : Enter a pattern name or ['?scnhd.lr user /
defined] < current > _ ) /

Respond : ANSI31. (402 fFerm)

Specify a scale for the pattern < 1.0000> : .
Respond : ! (for-default value) : /
Prompt : Specify an angle for the pattern <0 > : //

Respond : .|
Prompt : Select object

Respond : T SRTSHC Fiterd I aBIR (5T IS (18 ITS TA |

IV’
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31 Auto CAD-4Q TIZ® Unit format TSI T2 [arefEa-20os)
Auto CAD-9 I%S Unit format FAR T 49T command window (% units TR @B Yl
Drawing units set up dialogue box =LA | QTN Length Type, Angle Type, Precision, Angle direction, Units
to scale inserted oA STHTEHIPIE Cﬂﬁ M TR Units format TS{ F4T© XG4 | _
Qu |t iR Ry | [aaifal-2oso()]
HfeeTi%a @3 FRGTET e 8
yi HfEET u3fb 93 AER R Affee @ |
A1 AR TG SR R, 519 CUTTrD St TSER AT (A ST A |
o @7 HREE g fEg <y e <t o
8 | WW%VcncxWWWI .
¢ feenieE ATaieAE Edic 39 T | (- line type, line width 331t |

a1 g R wiReEmee o AR Tz P ot | [FrfTa- 20y o(R), se(afi)]
> W THRIAA 14, Dimension Style B3 |
| STRETCH command-«% T $y FIifRRl-2050]
Schnchcommandaammmwmwmwmuwﬁvmﬁﬁawamw; (g
T chaa ¥ g A W A
@1 Block Fuiten 7Ry Hy [eifiar-2053, so(#fR))

% At @& Objects W 0w 23 @ B 39 1 AT BrEere 921 (e 4R | (Tuw- wewia
et 2t 35, wFETE e & 3@ 30 | U3 3T W TSl T TF W3R AITB A9 T Inserl SR T |
0 | Eﬁwnit R Limits CT6 3210 A% o | \ [ArFfRTat-20 3> (7f), 38, S¢

) mftie @ Unit 76 FAIM O] #9030 command window (9 units % @R BIA Drawing units set

up dialogue box SIFRA | G¥ITH ATAGATR Length type, Angle type, Angle direction, Precision 3®7If Set up
99 A9 OK Click ¥TF unit set up Hﬂiﬂ’mm I :
Q49 KR @ limits G5 W1 FARX S command window 3 limits BT GBI 517 12 fesa saroseE

PR 3 |
Prompt : Lower left corner.
Respond .0, 0 focd @ B1= wifst
Prompt : Upper right cormer.
Respond : 607, 50/ (Architechtural units -3 &) ﬁTN GO SR limits (76 H“Tfm I
5 | Auto CAD-4% ARy w3 firger wee sefS 3t =4y [ar@frRi-2038)

Auto CAD 97 FIZCAT «3fb firgs weA TI9 o0 R qistete Smed 97
Units, limits GT8 IR *I¥ command window ¢S line/L Ty %1 wif*t |

Prompt : Specify first point :
Respond +2,2 T Enter Bif%t
Prompt . : Specify next point :
Respond : 5, 5 1= Enter 51
Prompt ': Specify next point :
Respond : 1, 8 1T Enter w1
"Prompt : Specify next point ;
Respond :2,2 T Bater 51171

ESC (5% Line TNIS &S (49 T00 Wi 1.
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Line command <7 TR 20 4, x 6 . wwmuﬁﬁw TR M| [AFTE 200k, 2053(7F)]

Auto CAD 6T 3 Dimension € Unit set up TR ﬁzﬁmww s f2 g
Eﬁtﬁacﬂwuneﬁm'ﬂmmLﬁw 913 B |

Prompt : Specify first point :

Respond | QT ﬁ"it@ fFs =@

Prompt : Line specify next point:

Respond 14, 0.

Prompt : Line specify next point :

Respond 10,6 4

Prompt : Line specify next point ;

Respond 4,04

Prompt : Line specify next point ;

Respond 10,64

Prompt : Line specify nexi point.:

Respond - : ESC (5T Line command (XT3 (I3 0 TR |
Auto CAD-« 13 R¥T Layer T w2t 71, =t fig | [ArifRiTar-20 0 ()]

TG TITSITS Layer TR GBR BIATT Layer properties manager dialogue box 679 TL& | A
New layer -q 519 AT Teet AR Layer (&%l TW | &fefB Layer-4 Lme type. color 11rn: weight,
Transparency TN set up A Layer o ==t A .

CoTAIR EFTIRCRRR AT 100cm X 12cm SHSTHER ST G e | Jarefaar-o0]

Auto CAD 6T %02 Dimension @32 Units set ¥fF 1 9T command window-S Line % 4%
5 U658 command&Ta St 37 |

Prompt : Specify first point

Respond - @ = fArs 3o IR

Prompt : Specify next point :

Respond @ 100<0 4

Prompt : Specify next point : A

Respond @12 <90° J

Prompt : Specify next point :

Respond . @ 100 < 180 4

Prompt : Specify next point :

Respond @12 <270J

Prompt : Specify next point.

Respond : ESC (6T Line command (T3 (I T T |
4 x 4 GFER ¥ rwD TR TS fird | [Fretical-200]

Auto CAD 6T TR %2 unit, Dimension mﬂ LI ﬁmmﬁeﬁ ST 3 | TS BarSiTe
REC ﬁm @B B | SR

Prompt : Specify first corner point :

Respond : @ A s i 3h

Prompt ~ : Specify other corner point :

Respond : 4,4 . Sras 3frwafs «0em anm |

ol x ¢ i, SRR WiHSrEEE G i T RS T, e e R g e -
e | | [RIift-205 8]

Auto CAD 9099 TR 912 Dimension 9% Units (A8 ¥ Line TE select TR e Trearet
SEEES L |

Prompt ~  : Specify first point :

Respond  :0,0.

Prompt : Specify next point :

¢
5
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Respond 1@ 3 <04

Prompt : Specify next point :

Respond 1@ 5«90 -

Prompt : Specify next point :

Respond @3 <180

Prompt : Specify next point :

Respond 1 @5<270.

Prompt : Specify next point. .

Respond +ESC (5UH Line command (YT G349 %00 113 4
CTHR- B3R TR A Teneterea T o )

(BB e g v g S -

1. Layer name

2. Layer on/off, Freeze, Lock, calor
3. Layer linetype

4. Layer Lineweight

5. Layer Transparency

6. Layer plot style etc,

Line command -9 TG 3B 6m x 8m TSN 8R 3R A% o |

) Auto CAD 6T 374 Dimension € Unit set up 991 17 i Frsere S T ¢

TR (FF (AT Line B8 9@ 1 L Bt @%@ w1fst

Prompt
Respond
Prompt
Respond
Prompt
Respond
Prompt
Respond
Prompt
Respond
Prormpt
Respond

Specify first point

@ ¢ frrs e afd
Line specify next point
6,01

Line specify next point
0,84

Line specify next point
6,04

Line specify next point
0.-8.

Line specify next point
ESC (vU¥ Line command (VT3 (32 Z07 113 |

Dimension style ARA¥TR command & 714 |

S.br AR TR @R 58 AL FEAT |

Polyline 0 Wi cotam cwares a2 commandemh o |

Z==f

ffs 2fgfmfie 22 (F0)-2

RITar-203 3]

[FrRTAl-205 ¢ (AHfa), S

FfEra-05e)

[ArfTal-Rod¢]

H . 5]
1w afB Polyline o o 372 | wa B crafte coamrer fadag command ST 6 i 577 3

Prompt
Respond
Prompt
Respond
Prompt

- Command : AREA

: Specific first corner point or [Object/Add/ Subtract]
: O T B Bifsr

: Select Object

. a7 foafb Select =fa

: Area = 21443.2026, perimeter = 728.2745
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(o) W4 Command : insert .1
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